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1
Introduction

The MA4000 Installation Manager User Guide provides the information 
needed to operate the Installation Manager application.

The following topics are included in this chapter:

Chapter Topics • MA4000 Installation Manager Overview
• How This Guide is Organized
• MA4000 Installation Manager Application Abbreviations

MA4000 Installation Manager Overview

The MA4000 Installation Manager application is designed to assist our 
NEC Associates/Partners and our NEC customers in gathering, 
correlating, customizing, validating and implementing their installation 
plan. This tool expedites the process of gathering this information, 
customizing it, and then turning the information into system 
programming. The number of hours required by a system technician 
using Maintenance Administration Tools to program the system is 
greatly reduced using the MA4000 Installation Manager. The larger the 
system, the greater the benefit.

The MA4000 Installation Manager contains a high level of import and 
export capabilities allowing sharing of information with many other 
types of applications. Using these capabilities makes it possible to easily 
re-use the information in other NEC Unified Solutions, Inc. products, as 
well as common tools such as Microsoft Excel.
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How This Guide is Organized

Chapter 1
Introduction

This chapter outlines how to use this manual, including actual manual 
organization, chapter layout, keyboard conventions, function keys, and 
basic terminology for the MA4000 Installation Manager application.

Chapter 2
Getting Started

This chapter explains the hardware and software requirements of 
MA4000 Installation Manager, and lists the steps needed to install the 
application.

Chapter 3
Graphical User Interface

This chapter provides an overview of the various interfaces of the 
MA4000 Installation Manager software.

Chapter 4 
Project Information

This chapter describes the fields and buttons contained in the Project 
Information section of the MA4000 Installation Manager software.

Chapter 5 
Hardware Information

This chapter describes the fields and buttons contained in the Hardware 
Information section of the MA4000 Installation Manager Software.

Chapter 6 
System Information

This chapter describes the fields and buttons contained in the System 
Information section of the MA4000 Installation Manager software.

Chapter 7 
Advanced Features

This chapter describes the fields and buttons contained in the Advanced 
Features section of the MA4000 Installation Manager software.

Chapter 8 
User Assignments

This chapter describes the fields and buttons contained in the User 
Assignment section of the MA4000 Installation Manager software.

Chapter 9 
Group Assignments

This chapter describes the fields and buttons contained in the Group 
Assignments section of the MA4000 Installation Manager software.

Chapter 10 
Circuit Card Assignments

This chapter describes the fields and buttons contained in the Circuit 
Card Assignments section of the MA4000 Installation Manager software.

Chapter 11 
Install

This chapter describes the fields and buttons contained in the Install 
section of the MA4000 Installation Manager software.

Chapter 12 
Reports

This chapter describes the fields and buttons contained in the Reports 
section of the MA4000 Installation Manager software.

Chapter 13 
Productivity Features

This chapter describes the fields and buttons contained in the 
Productivity Features section of the MA4000 Installation Manager 
software.
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MA4000 Installation Manager Application Abbreviations

CCIS Common Channel Inter-office Signaling

CSR Customer Service Representative

DM Data Memory

DTI Digital Trunk Interface

FCCS Fusion Call Control Handling

FCH Fusion Call Handler

GUI Graphical User Interface

IM Installation Manager

IM Project (or just Project) A project is the set of data that is associated with a specific installation. 
It is assumed that an installation corresponds to a single customer. 
Therefore, each customer/installation should have its own project.

A project is not stored in a single file as you might expect (as it is in 
Microsoft Access or Microsoft Excel). As data is collected, the 
information is stored in the Microsoft Desktop Engine (MSDE) which is a 
server-based database. The management of this information will require 
some features within the application to access, remove, and backup this 
information.

IM Project Template This is the database containing all information for a particular 
installation. It includes all templates, all customer users, and related 
information to the installation.

LCN Local Control Node

LDM Local Data Memory

LMG Local Module Group

MAT Maintenance Administration Terminal

MC Media Converter

MG Media Gateway

MPS Multi-Purpose Server

MSDE Microsoft Desktop Engine — a mini SQL Server

NCN Network Control Node

NDM Network Data Memory

UMG Ultra Module Group
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2
Getting Started

This chapter lists the hardware and software requirements necessary to 
operate the MA4000 Installation Manager. The chapter also provides the 
steps needed to install the MA4000 Installation Manager application. 

Chapter Topics • Requirements
• MA4000 Installation Manager Installation
• Initializing the Flash Card and Installing the System Software 

(SV7000 MPS Only)

Requirements

MA4000 Installation Manager contains a feature called Localization. This feature is 
transparent to the user. When a user installs MA4000 Installation Manager, the user 
will be prompted for different markets (language, basic data, etc.). For example, in 
order to have a different language, NEC will need to send to the user a package of 
files containing a utility to translate all the English descriptions to the new language. 
The user will then need to perform the language translation and modify the basic 
data to the files, then send it to NEC. After NEC receives the updated package, NEC 
will re-complle the MA4000 Installation Manager with the new language and basic 
data.

In order for the MA4000 Installation Manager to operate properly, your 
operating environment must meet the requirements listed in Table 2-1.

IMPORTANT

IMPORTANT

MA4000 Installation Manager requires Microsoft SQL Server Desktop Engine 
(MSDE) 2000. If a database server is already installed then you might be required to 
remove any conflicting database servers. Keep in mind the MA4000 Installation 
Manager will be compatible with SQL Server 2000 but the operating systems 
identified in Table 2-1 will not support MS SQL server. A server class operating 
system is required to support SQL Server 2000. 
 
MSDE 2000 is available to install from the MA4000 Installation Manager CD.
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Table 2-1  System Requirements

Minimum Recommended
Operating System

Windows 98
Note:This is the bare minimum operating system.

Windows NT 4.0 (Service Pack 5 or later)
Windows 2000

(Service Pack 3 or later)
Window XP Professional
(Service Pack 1 or later)

Note:This is the preferred operation system.

Note: Other Windows operating systems may work, but will not be supported because of testing 
limitations. Users of Windows ME and Windows XP Home Edition will probably be able to 
successfully run MA4000 Installation Manager but these are not considered business operating 
systems.

Processor

Pentium 400 MHz Pentium 700 MHz

Memory

64 MB 128 MB, or more

Hard Drive Space (available before installation)

250 MB 300 MB, or more

Monitor

800x600 SVGA 1024x768 SVGA

Web Browser (for support only)

Any HTML 1.1 compliant Internet Explorer 5.5, or greater

Ethernet Port

10/100 MB Ethernet Port for connecting to SV7000-T and SV7000S

Serial Port

For configuration of Peripheral Hardware (MC, MG, VS)

Modem

For SV7000-T software registration

PCMCIA Card Slot

Intel compatible PCMCIA card slot for use when initializing SV7000-T Flash Card

Database

Microsoft MSDE 2000 (Included on CD-ROM)

Additional Hardware

CD-ROM CD-ROM 2x, or higher

Mouse and 101 Keyboard Mouse and Keyboard
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MA4000 Installation Manager Installation

To install MA4000 Installation Manager for the first time, use the 
installation CD included in your MA4000 Installation Manager package. 
You must run Setup from within Windows.

The following procedure walks you through the MA4000 Installation 
Manager installation. The Setup consists of a series of dialogs that 
supply you with default answers to questions regarding the installation 
of files to your hard disk. To accept the default answers, click the Next 
button. To make changes, click the Browse button and select a different 
directory, then click OK button to return to the dialog box.

The following procedure assumes you are starting the Setup program 
from your computer’s CD-ROM drive D:. If you start from a different 
drive, substitute the letter of that drive in this procedure.

Step  1 Launch Microsoft Windows 98, Windows 2000 or Windows XP 
Professional.

Step  2 Place the MA4000 Installation Manager CD in the CD-ROM drive.

Step  3 Click the Windows Start button and select Run.... from the pop-up menu. 
The Run (Figure 2-1) displays.

Figure 2-1  Run 

Step  4 Type D:\Setup in the Open text box (as shown in Figure 2-1) and click 
the OK button. The Installation Manager R25 - InstallShield Wizard 
Welcome displays (Figure 2-2).

NOTE

Be sure to close all open Windows programs and screen savers and disable any 
virus detection programs before using the Setup program.
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Figure 2-2  Installation Manager R25 - InstallShield Wizard Welcome 

Step  5 Follow the prompts in the Setup program to accept the software licensing 
agreement, to enter your customer information, and to select the setup 
type. The Setup program copies the required files to your hard drive. 

Step  6 The Installation Manager R25 - InstallShield Wizard Complete displays 
(Figure 2-3) after the Setup program has finished copying files to your 
hard disk. 
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Figure 2-3  Installation Manager R25 - InstallShield Wizard Complete 

Step  7 Click the Finish button. The Installation Manager R25 - InstallShield 
Install Feature(s) displays (Figure 2-4). 
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Figure 2-4  Installation Manager R25 - InstallShield Install Feature(s)

Step  8 Select the appropriate check box to install the desired feature. After 
MA4000 Installation Manager finishes installing each selected feature, 
you can now run the MA4000 Installation Manager program.

Download from Www.Somanuals.com. All Manuals Search And Download.



Getting Started         2-7

MA4000 Installation Manager User Guide - Revision 7

Initializing the Flash Card and Installing the System Software 
(SV7000 MPS Only)

The following procedure contains a step which can result in the loss of existing data 
on your computer if performed improperly. This step is indicated with a Caution 
symbol. If you are unsure whether you understand the step completely, contact the 
NEC Technical Assistance Center (NTAC) before proceeding.

Introduction and Requirements
The SV7000 MPS ships with an empty ATA flash card. Before you start 
the server, you must initialize the card and load it with system software 
the server requires to run. Then, you use the flash card to transfer the 
system software to the server itself.

This procedure requires the system software CD (supplied with your 
system) and a laptop PC with a PCMICIA card slot. Your laptop PC must 
be configured to boot from the CD drive.

The SV7000 MPS runs the Linux operating system. When you boot from 
the supplied system software CD, your laptop will also be running Linux. 
You can then use Linux to initialize the flash card and transfer the MPS 
system software to it.

You should also be familiar with the NEC Maintenance and 
Administration Terminal (MAT) application. For specific information on 
using the MAT, consult its online help documentation.

Major Tasks
The following lists the major tasks you will complete when you initialize 
the flash card and load system software on the MPS:

• Boot your laptop from a CD containing the Linux operating system.
• Use the Linux command line interface to format the flash card.
• Copy the MPS operating system files to the flash card.
• Insert the flash card in the MPS server.
• Connect your laptop directly to the MPS.
• Copy the system software from the flash card to the MPS.
• Specify the MPS’ new TCP/IP network settings.
• Restart the MPS using the new network settings.

CAUTION

NOTE

To configure your PC to boot from a CD, you may need to change the boot drive 
order in your computer’s BIOS. You can usually display the BIOS settings screen by 
pressing a specific key during the boot sequence.

For specific information on configuring your laptop to boot from a CD, consult your 
computer’s documentation.
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Step-by-Step Procedure
To initialize the flash card, install it in the server, and load the MPS 
system software do the following:

Step  1 Insert the MPS system software CD into your computer, then reboot.

—Linux status messages display, followed by a video mode prompt.

Step  2 Press Space to accept the default video mode. A keyboard selection 
prompt displays.

Step  3 Press Enter to accept the default keyboard configuration. A Linux 
command prompt displays.

Step  4 Enter root as the login ID, then enter xxxx as the password (the 
password entry will not display on the screen).

—The Linux command prompt changes to #, indicating you are logged in 
as a root user.

You must enter these values exactly as they are shown here because the Linux 
operating system, unlike Windows, is case-sensitive. That is, root and Root are not 
identical.

Be careful to enter the values in the remaining steps exactly as they are shown, 
including spaces.

Step  5 Type the following at the command prompt, then press Enter:  
 
/bin/dmesg  |  grep hd

—A list of configured devices on your PC displays, designated hda, hdb, 
hdc, etc.

Step  6 Use the list of displayed devices to locate your laptop’s hard drive and 
CD-ROM drive. Write down their designations (hda, hdc, etc.) so you will 
remember them.

It is critical you correctly identify your CD-ROM and internal hard drive from the list of 
displayed devices. You will need the correct designation in later steps to select which 
device will be formatted.

Linux identifies drives on your computer with the hd designation, plus a letter starting 
with a and continuing alphabetically. Commonly, the internal hard drive is hda and 
the internal CD-ROM is hdc. However, your configuration may be different. You can 
identify your drives using the information displayed after the previous step. For 
example, here is a possible drive listing:

hda: HTS54809349, ATA disk drive
hdc: Samsung CDRW-DVD, ATAPI CD-ROM drive
hda: HTS54809349, 76319MB w/ 7877kB cache
hdc: ATAPI 24X DVD-ROM CD-RW drive, 2048kB cache
hda: hda1, hda2

This listing shows the internal 80MB hard drive as hda. You can easily identify the 
CD-ROM drive as hdc.

IMPORTANT

IMPORTANT
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Step  7 Type the following at the command prompt, the press Enter: 
 
mount  /dev/hdc  /mnt/cdrom 
 
Replace hdc in the command, if necessary, with the designation your 
laptop uses for the internal CD-ROM device.

—Linux mounts the CD-ROM and informs you the device is read-only.

Step  8 Type the following at the command prompt, then press Enter: 
 
/mnt/cdrom/MKINIT 
 
After a few moments, the MKINIT finish message displays.

Step  9 Insert the flash card in your laptop’s PCMCIA card slot.

—Linux reads the card and displays its size and drive designation (hde, 
etc.). You will need this drive designation in Step 11.

Step  10 Press Enter to return to the command prompt (#).

This next step will destroy any existing data on the specified device. Be certain you 
have not entered the designation for your laptop’s hard drive when typing this 
command.

Step  11 Type the following at the command prompt, then press Enter: 
 
MK_FLASH hde 
 
Replace hde in the above command, if necessary, with the drive 
designation your laptop displayed for the flash drive after you inserted 
the card.

—You can ignore the DriveReady and DriveStatus error messages. 
—The write finish status message displays when the flash card 

initialization completes. This process may take 20-30 minutes.

Step  12 Remove the flash card from your laptop.

—You can ignore the resulting error messages.

Step  13 Type the following at the command prompt, the press Enter: 
 
exit

Step  14 Remove the MPS system software CD from your laptop.

Step  15 Reboot your laptop in the normal manner.

—After it reboots, it should be running the Windows operating system.

Step  16 Be sure the MPS is OFF, then insert the flash card in the appropriate slot.

Step  17 Turn the MPS ON.

CAUTION
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Step  18 Connect an ethernet cable between your laptop and the Ether1 jack on 
the front of the MPS.

—You must use a crossover Ethernet cable, not the more common 
straight-through type.

Step  19 On your laptop, open the Network (or Network Connections) control 
panel.

Step  20 Change your laptop’s network settings to the following: 
 
IP Address: 192.168.0.5 
Subnet Mask: 255.255.255.0 
Default Gateway: 192.168.0.254

Step  21 Close the network control panel to save the new settings.

Step  22 Launch the PC Pro by doing one of the following:

—Open Installation Manager, then select PCPro... from the Tools menu. 
—Locate the PCPro application on your hard drive (if previously 

installed) and launch it.

Step  23 Log on to the MPS using its default IP (192.168.0.1), leaving the user 
and password fields blank.

Step  24 Enter the ADTM command in the PCPro to display the default switch 
configurations.

Step  25 Change the MPS’ IP address, subnet mask, and default gateway 
address to the appropriate values for your network.

Step  26 Click Apply.

Even though the values appear to revert to their default values, they have in fact 
been changed. This is because although you have changed their value in the MPS’s 
memory, they have not yet been stored to the flash card.

Step  27 Enter the SINZ command in the MAT, then select System Initialize 
(Reboot).

Step  28 Click Execute. A confirmation dialog displays.

Step  29 Click Yes. The MPS reboots. 

—During this time the ACT light flashes GREEN and the Load light is 
RED.

—The MPS is not ready until the ACT light remains solid GREEN.

Step  30 Change your laptop’s TCP/IP network settings back to their original 
values for use on your network. 

NOTE
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3
Graphical User Interface

This chapter provides an overview of the components of the MA4000 
Installation Manager software.

The following topics are included in this chapter:

Chapter Topics • General Graphical User Interface Features
• Startup Dialog
• Pull-Down Menus
• Primary Sections

General Graphical User Interface Features

Data Navigator
The Data Navigator control allows you to easily go from item to item in a 
list. There are buttons allowing you to go to the beginning and the end 
of the list using a single button click. 

The Data Navigator always displays information in the form [last 
selected row] of [total rows] (see Figure 3-1). 

Figure 3-1  Data Navigator Single Select example
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If multiple rows are selected the display will be listed in the form [last 
selected row] of [total rows] (see Figure 3-2).

Figure 3-2  Data Navigator Multi Select example

Example: If the list is displaying Row #1 at the top of the list, and the 
user has made the selections from top to bottom, the last row 
selected would have been Row #12.
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Selecting
All list boxes will support the ability to multi-select items. There are two 
ways to multi-select items: 

Step To select a range of rows that are consecutive:

—Select the first item in the range
—Hold the Shift key and select the last item in the list. All items in 

between will be selected. In Figure 3-3, the fourth item in the list and 
then the seventh item were selected while holding the Shift key. All 
items between were selected.

Figure 3-3  List Box Contiguous Select example

Step Another method is to choose multiple items by selecting rows while 
holding the Control key. This allows the selection of non-consecutive 
items. In Figure 3-4, the fourth, sixth, and eighth items were selected. 

Figure 3-4  List Box Multi-Select example

If you choose an operation, such as clicking the Edit button, you will be 
editing all the selected records in a smaller list. Figure 3-5 displays how 
this would appear if you chose four items from the list, and then clicked 
the Edit button.
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Figure 3-5  Edit Multiple Records example

List Box Sorting
All lists will have the ability to sort. Clicking on the title bar of a column 
causes the list to be sorted alphabetically by that column. A second click 
will reverse the sort order. Clicking in a different column will cause the 
list to be sorted by that column. There will be an arrow in the column 
currently being sorted. Figure 3-6 indicates the Status field is being 
sorted alphabetically. Another click on the title would cause the sort to 
reverse and the arrow would be pointing UP instead of DOWN.

Figure 3-6  List Box Sorting example
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Startup Dialog

MA4000 Installation Manager projects are not comprised of a single file 
like a spreadsheet or document. Instead, the project is consists of 
information contained in a database. To support this, your are given the 
Installation Manager Startup (Figure 3-7) to perform basic management 
on MA4000 Installation Manager projects.

Figure 3-7  Installation Manager Startup 

• Projects tab
The projects listed here were created using the default template.

• Templates tab
 The projects listed under this tab were created using a template 
based on criteria other than the default template. 

You have the ability to have multiple instances of MA4000 Installation 
Manager running. However, each instance will only be allowed to edit a 
project that is not already opened.

Once the user opens a project Figure 3-7 disappears. To open another 
instance of MA4000 Installation Manager, you must return to the 
shortcut used to launch MA4000 Installation Manager. The MA4000 
Installation Manager installation will place a shortcut on the Windows 
Start Menu.
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Projects Tab

Figure 3-8  Projects Tab 

New button
You will have several choices to make. Some of the most powerful 
features of MA4000 Installation Manager is the ability to re-use previous 
data. When a new project is defined, it can be defined from an existing 
project so you do not have to start with an empty project. Clicking the 
New button displays the Welcome to the Create Project Wizard (Figure 
3-9).

Figure 3-9  Welcome to the Create Project Wizard 
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Create Project Wizard

Step  1 The Welcome to the Create Project Wizard greets you and informs you 
that the wizard will be guiding you through the steps necessary to create 
a new project. The panel also warns you that some basic information will 
be needed to complete the wizard. Click the Next button to continue. The 
Create Project Wizard - Project Name and Type dialog box (Figure 3-10, 
Figure 3-11, Figure 3-12, Figure 3-13 or Figure 3-14) displays. 

Figure 3-10  Create Project Wizard - Project Name and Type - NEAX IPX and NEAX IPX DM
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Figure 3-11  Create Project Wizard - Project Name and Type - NEAX IPX UMG
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Figure 3-12  Create Project Wizard - Project Name and Type - UNVERGE IPX
\
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Figure 3-13  Create Project Wizard - Project Name and Type - UNIVERGE SV7000
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Figure 3-14  Create Project Wizard -Project Name and Type - UNIVERGE SV8500

Step  2 The Create Project Wizard - Project Name and Type dialog box allows 
you to enter a name for the project. 

—Enter the project name in the Project Name field. The name must be 
unique. There must not be any other projects using this name. 

—Select the system type from the System Type drop-down menu.
•  Business System
•  Hospitality System

—Select the system type from the Hardware Type drop-down menu.
•  NEAX IPX
•  NEAX IPX DM
•  NEAX IPX UMG
•  UNIVERGE IPX
•  UNIVERGE SV7000
•  UNIVERGE SV8500

—Select the physical chassis count from the Physical Chassis Count 
drop-down menu.
•  NEAX IPX / NEAX IPX DM / UNIVERGE IPX: 1 to 16
•  UNIVERGE SV7000 / UNVERGE SV8500: 0, 1, 2, 3, and 4

Select the 6U Physical Chassis check box if your system uses a 6U-size physical 
chassis. (Not available on NEAX IPX, NEAX IPX DM, or UNIVERGE SV8500)

NOTE
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•  NEAX IPX UMG: None
—Select the maximum chassis count from the Virtual Chassis Count 

drop-down menu. 
•  NEAX IPX / NEAX IPX DM / UNIVERGE IPX: 0, 1, 2, and 3.
•  NEAX IPX UMG: None

—Select the maximum system capacity from the System Maximum 
Capacity drop-down menu. 
•  NEAX IPX / NEAX IPX DM / NEAX IPX UMG / and 
   UNIVERGE IPX: None
•  UNIVERGE SV7000: 300, 750, 1000, 1500, 2000, 2500, 3000,  
   3500, 4000, 4500, 5000, 5500, and 6000
•  UNVERGE SV8500: 384, 768, 1152, 1536, 1920, 2304, 2688, 3072, 
   3456, 3840, 4224, 4608, 4992, 5376, 5760, and 6144

—Select the Use Phase Installation check box to enable the phased 
installation.
•  All Systems Types: Available.

Click the Next button to proceed. Figure 3-15 displays.

Figure 3-15  Create Project Wizard - Project Category and Notes 

Step  3 The Create Project Wizard - Project Category and Notes allows you to 
provide additional information about the project, and permits you to 
categorizing the project. 

Step  4 Click the Next button to proceed. Figure 3-16 displays.
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Figure 3-16  Create Project Wizard - Customer Locations 

Step  5 The Create Project Wizard - Customer Locations is similar to the 
Customer Organization (Step 6). It allows you to specify locations for all 
telephone so they can be accurately delivered to the necessary 
locations. This information is also very important when cabling personnel 
have to complete the end to end connectivity from the telephone to the 
Voice Server system.

Click the Next button to continue. Figure 3-17 displays.
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Figure 3-17  Create Project Wizard - Customer Organization 

Step  6 The Create Project Wizard - Customer Organization allows you to name 
the levels in a customer's organization. It is very similar to naming the 
levels in a company's organizational chart. These levels are used heavily 
to sort out relevant data. This is particularly powerful when there are 
large numbers of phones/employees and the user is trying to set up hunt 
groups based on a department within the company.

Click the Next button to continue. Figure 3-18 displays.
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Figure 3-18  Create Project Wizard - Voice Mail

Step  7 The Create Project Wizard - Voice Mail allows you to choose from any 
supported voice mail system. Current selections include:

<None>

<Other Voice Mail>

NEAX Mail AD-64 - A voice messaging system providing ViewMail®, 
ViewMail for Microsoft® Messaging, ViewMail for Lotus® Notes®, 
ViewMail for GroupWise®, and ViewCall® Plus (Windows 2003-based).

UM8500 Exchange Message Store - A voice messaging offering 
powerful productivity features such as VideoMail, Find Me Follow Me and 
Desktop Call Control (IP-based).

UM8500 SQL Message Store - A voice messaging offering powerful 
productivity features such as VideoMail, Find Me Follow Me and Desktop 
Call Control (IP-based).

UNIVERGE UM4730 - A voice messaging system providing 
TeLANophy® modules, ViewMail®, ViewMail for Microsoft® Messaging 
and ViewCall® Plus (PC-based/Linux OS).

Click the Next button to proceed. Figure 3-19 displays.
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Figure 3-19  Create Project Wizard - Customer Contact Information 

Step  8 The Create Project Wizard - Customer Contact Information allows you to 
enter details about the customer that is custom to this new project.

Click the Next button. Figure 3-20 displays.
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Figure 3-20  Completing the Create Project Wizard

Step  9 The Completing the Create Project Wizard is the last panel you will 
encounter as part of the Create Project Wizard. 

Click the Finish button to end the Wizard and return to Figure 3-7.
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• Import button

Step  1 Click the Import button as shown in Figure 3-21.

Figure 3-21  Projects Tab 

Figure 3-22 displays.
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Figure 3-22  Import Project 

Step  2 Select an existing project and click the Open button. The selected 
project now appears in the Select Project: section of the Installation 
Manager Startup.

• Delete button

Step  1 Select a project from the list located in the Installation Manager Startup 
(Figure 3-7).

Step  2 Click the Delete button. Figure 3-23 will display. 

Figure 3-23  Delete Project Confirmation
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• Delete All button

Step Click the Delete All button. Figure 3-24 will display. 

Figure 3-24  Delete All Projects Confirmation

•

Clicking the Yes button deletes a project entirely and removes the project from the 
database. The project cannot be recovered.

Refresh button 

The Refresh button performs a new search in the database to 
discover all projects defined on the current personal computer. The list 
will be updated with the latest information. 
 

• OK button
The OK button will open the selected project and make it available for 
editing.

• Cancel button
The Cancel button is used to abort opening any project. You will need 
to re-launch the application using MA4000 Installation Manager 
shortcut.

WARNING
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Templates Tab

Figure 3-25  Templates Tab 

• New button 
 
Highlighting a template listed in the Select Template: section, and 
clicking the New button, will show the same Figure 3-9 through Figure 
3-20 dialog boxes as the Project Tab displayed. This option provides 
you the opportunity to modify the imported template to meet your 
specific requirements. 

• Import button

Step  1 Click the Import button. Figure 3-26 displays.
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Figure 3-26  Import Template

Step  2 Select the template to import from those templates listed, and click the 
Open button. 

• Delete button

Step  1 Select a template from the list located in the Installation Manager Startup 
(Figure 3-7).

Step  2 Click the Delete button. Figure 3-27 will display. 

Figure 3-27  Delete Project Confirmation
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• Delete All button

Step Click the Delete All button. Figure 3-28 will display. 

Figure 3-28  Delete All Projects Confirmation

•

Clicking the Yes button deletes a template entirely and removes the template from 
the database. The project cannot be recovered.

Refresh button 

The Refresh button performs a new search in the database to 
discover all templates defined on the current personal computer. The 
list will be updated with the latest information. 
 

• OK button 
 
The OK button will open the template project and make it available 
for editing. 

• Cancel button 
 
The Cancel button is used to abort opening any template. You will 
need to re-launch the application using MA4000 Installation Manager 
shortcut.

WARNING
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Pull-Down Menus

File Menu

The File pull-down menu contains these file functions:

• Create Project...
• Open Project...
• Save As 

— Project...
— Template...

• Exit

Edit Menu
The Edit pull-down menu (Figure 3-29) contains the common functions 
typically found in stand-alone applications.

Figure 3-29  Edit Menu 

Cut (Ctrl+X)

Step  1 Select an item (this could be the context of a text box, or it could be 
multiple items in a list). 

Step  2 After a selection is made, press the Ctrl and X keys to place the contents 
in the Windows Clipboard. 

Step  3 You can now paste the contents to another location, such as another 
windows application, or to another location within MA4000 Installation 
Manager.
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Copy (Ctrl+C)

Step  1 Select an item (this could be the context of a text box, or it could be 
multiple items in a list).

Step  2 After a selection is made, press the Ctrl and C keys. A copy of the 
selected item(s) is placed on the Windows Clipboard. 

Step  3 You can now paste the contents to another location, such as another 
windows application, or to another location within MA4000 Installation 
Manager. See Paste (Ctrl-V)

Paste (Ctrl-V)

Step  1 Place the curser in the field or in the row below where the contents of the 
Windows Clipboard is to be pasted. 

Step  2 If an item is selected, then the past operation will replace the selected 
item. In the case of a list box, the contents of the clipboard will be pasted 
above the cursor location. 

The contents of the clipboard must have the same number of columns as 
the destination list box. If it does not have exactly the same number of 
columns, the operation will not occur.

Tools Menu
The Tools pull-down menu (Figure 3-30) contains the Flash Card 
Wizard, Registration Wizard, PCPro, License Verification Tool, 
Clipboard, and Network Manager functions.

Figure 3-30  Tools Menu 

Flash Card Wizard ...

UNIVERGE SV8500 is not supported by the Flash Card Wizard function. 

The Flash Card Wizard does not work on MPS due to MPS being Linux-based. See 
Registration Wizard ...  for procedure to upgrade the system.

The Flash Card Wizard option provides the tools to:

• Format and write new program files to a new flash card
• Upgrade the program files by reading program files to the personal 

computer and modifying the files using Explorer to write to the flash 

WARNING

NOTE
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card, or backup data by reading data from the flash card to the 
personal computer. See Figure 3-31.   

To launch the Flash Card Wizard, do the following:

Step From Microsoft Desktop, select Start > Programs > Installation 
Manager 24 > Flash Card Wizard. 
 
OR

Step From the Installation Manager Menu Bar, click Tools > Flash Card 
Wizard ....

Figure 3-31  FLCVTR Initial 

• If the Initial Installation Execute button is clicked, Figure 3-32 
displays.

IMPORTANT

The flash card installation needs to be installed using the MPS System CD-ROM.
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Figure 3-32  FLCVTR Initial Installation Execute 

Step  1 Insert an unformatted flash card into an available PCMCIA slot. Ensure 
you insert a flash card prior to launching the FLCVTR program in order to 
display the PC’s PCMCIA slot for the Flash Card field.

Step  2 Click the Browse button to locate the file containing the program to be 
written to the flash card.

If defining the partition size is necessary, select the appropriate size from the pull-
down menu located in the Partition Size (MB) field. Normally, the Partition Size 
(MB) field is not visible, choose the Option menu item and select the PartitionSize 
Select option to make the field visible.

Step  3 Select the PCMCIA slot for the flash card.

Step  4 Click the Set button to write the program to the flash card.

Step  5 After pressing the Set button, Figure 3-33 displays.

NOTE
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Figure 3-33  Setting INITDATA 

Step  6  Enter the IP Address, Subnet Mask and Gateway of the SV7000, then 
click the Set button.

This option only applied to the SV7000, and is not available for a NEAX 2400 IPX.

NOTE
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• If the Program Upgrade Execute button is clicked, Figure 3-34 
displays.

Figure 3-34  FLCVTR Program Upgrade Execute 

Step  1 Insert the flash card containing the program files into an available 
PCMCIA slot.

Step  2 In the Drive field, choose the drive containing the program files and the 
location where the files are to be written.

If the Drive field is not visible, choose the Option menu item and select the Drive 
Select option.

Step  3 Select the PCMCIA slot for the flash card.

Step  4 Click the Browse button to locate the folder or CD Drive where the 
Program Files are located. 

Step  5 Click the Set button to load the Program Files to the Flash Card.

TIP
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• If the Data Backup Execute button is clicked, Figure 3-35 displays.

Figure 3-35  FLCVTR Data Backup Execute 

Step  1 Insert the flash card containing the program files into an available 
PCMCIA slot.

Step  2 In the Drive field, choose the drive containing the office data files and the 
location where the files are to be written.

If the Drive field is not visible, choose the Option menu item and select the Drive 
Select option.

Step  3 Select the PCMCIA slot for the flash card.

Step  4 Click the Browse button to locate the folder where the office data files 
will be written.

Step  5 Click the Get button to write the office data files located on the flash card 
to the location selected.

TIP
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Registration Wizard ...

The Registration Wizard screens that display for the UNIVERGE SV8500 system will 
be different from the screens shown in the following example.

The Registration Wizard connects your system to the NEC 
Registration Service and obtains your Activation Code. See Figure 3-36.

To launch the Registration Wizard, do the following:

Step From Microsoft Desktop, select Start > Programs > Installation 
Manager R25 > Registration Wizard. 
 
OR

Step From the Installation Manager Menu Bar, click Tools > Registration 
Wizard ....

Figure 3-36  Welcome to the Registration Wizard 

Step  1 Select the Next button to proceed. Figure 3-37 displays.

NOTE
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Figure 3-37  NEC Registration Wizard - We Want To Know About You 

Step  2 Select the Next button to continue. Figure 3-38 displays.
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Figure 3-38  NEC Registration Wizard - Site Information 

Step  3 Enter the site information requested. Those fields denoted with an 
asterisk require an entry.

Step  4 Click the Next button to continue. Figure 3-39 displays.
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Figure 3-39  NEC Registration Wizard - Complete Your NEC Registration 

Step  5 Click the Next button. Figure 3-40 displays.
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Figure 3-40  NEC Registration Wizard - Select System to Activate 

Step  6 Select the appropriate system from the list provided.

—Direct Connection to the System. Enter the communication port and 
baud rate. 

— IP Connection to the System. Enter the IP address.

The IP address entered here will determine the system information that will display 
when Get System Information is selected in Step 8. 

—Modem Connection to the System. Select the modem type, enter 
the dialing number, and create, edit or retrieve a connection profile. 
Click the Save Connection button to save the modem profile.

Step  7 Click the Next button. Figure 3-41 displays.

NOTE
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Figure 3-41  NEC Registration Wizard - Gather Security Codes from System - SV7000 Example

Step  8 Click Get System Information to connect your system and obtain/
update the hardware and software key codes, then click the Next.  
Figure 3-42 displays for all systems except UNIVERGE SV8500.  
 
For UNIVERGE SV8500, when Next is clicked, the Choose Options to 
Activate Your UNIVERGE SV8500 dialog displays providing options for 
obtaining/uploading the needed SVI.zip file or for proceeding directly to 
the UNIVERGE 8500 Activation Step.

—If you do not already have a SVI.zip file, use the Obtain SVI File steps 
listed in Table 3-1 to retrieve the license file.

—If you have a SVI.zip file and want to upload it to the UNIVERGE 
SV8500, use the Upload SVI File steps listed in the same table.

—If you wish to skip the two options above and proceed directly to the 
UNIVERGE SV8500 Activation Step, use the Activate steps listed in 
the table. 
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Table 3-1  Options to Activate the UNIVERGE SV8500 

Obtain SVI File Upload SVI File Activate
Step 1. Login to the License 

Management Server 
(LMS) and download the 
SVI.zip file. 

Step 2. Load the SVI.zip file to the 
UNIVERGE SV8500.

Step 3. Obtain the Key Code File 
from the UNIVERGE 
SV8500.

Step 4. Upload the Key Code File 
to the LMS and obtain the 
Activation Code from the 
LMS (either by web 
display or e-mail).

Step 5. Register the Activation 
Code to the UNIVERGE 
SV8500.

Step 1. Load the SVI.zip file to the 
UNIVERGE SV8500.

Step 2. Obtain the Key Code File 
from the UNIVERGE 
SV8500.

Step 3. Upload the Key Code File 
to the LMS and obtain the 
Activation Code from the 
LMS (either by web 
display or e-mail).

Step 4. Register the Activation 
Code to the UNIVERGE 
SV8500.

Step 1. Upload the Key Code File 
to the LMS and obtain the 
Activation Code from the 
LMS (either by web 
display or e-mail).

Step 2. Register the Activation 
Code to the UNIVERGE 
SV8500.
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Figure 3-42  NEC Registration Wizard - Registration Information 

Step  9 In the Modem Configuration Section, enter or select the correct 
information into the Modem Name and Registration Server Dialing 
Number fields.

Step  10 Click Connect to NEC Registration Server and obtain the Activation 
Code.

—The modem defined in Step 9 calls into the server and retrieves the 
Activation Code, or you can select the By TCP-IP option button to 
connect using that method.

—The activation code will display in Activation Code field after 
successful registration with the NEC Registration Service.

Step  11 Select the Next button. Figure 3-43 displays.
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Figure 3-43  NEC Registration Wizard - Activate Your System 

Step  12 To activate your system, click the Next button. Figure 3-44 displays.
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Figure 3-44  NEC Registration Wizard - System Activation

Step  13 Select the Send Activation License button to activate your system. 

Step  14 Select the Next button to proceed. Figure 3-45 displays.

If the Activation License field is empty, you can either go back and connect to the 
NEC Registration Server or temporarily activate your system with the Unlock button.

NOTE
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Figure 3-45  NEC Registration Wizard - Congratulations 

Step  15 Click the Finish button to exit the Registration Wizard.

PCPro ...
The PCPro provides centralized online HTML-based programming access, 
allowing administraators to manage terminals, schedule maintenance 
and firmware updates, and remotely make moves, additions, or 
changes.

Experienced users who wish to use the PCPro to send commands 
directly to the switch can launch it from within Installation Manager.

To launch the PCPro, do the following:

Step  1 Launch the Installation Manager. The Startup dialog displays.

Step  2 Select an existing project or create a new project. The Installation 
Manager main screen displays.

Step  3 Select Tools > PCPro.... The PCPro launches and displays as a 
separate application.
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License Verification Tool ...

SV8500 does not support the License Verification Tool function.

The License Verification Tool provides a brief summary of the primary 
licenses that are available (and in use) on your SV7000 system.

To launch the License Verification Tool, do the following:

Step From Microsoft Desktop, select Start > Programs > Installation 
Manager R25 > License Verification Tool. 
 
OR

Step From the Installation Manager Menu Bar, click Tools > License 
Verification Tool ....

 
Clipboard...
Installation Manager now provides experienced users with integrated 
access to the MAT Clipboard application. You can use this tool to access 
MAT commands and transfer information directly to the Voice Server or 
work offline and upload all changes at once.

The Clipboard can save command data from the Voice Server as XML 
(Extensible Markup Language) files. You can then edit the XML files 
using Microsoft Excel and upload the modified data back to the Voice 
Server. Many MAT commands are time-consuming when programmed 
individually. Using the Clipboard to download and upload the command 
data in a single operation can make many tasks more efficient. For 
example:

• Create an off-line XML file containing a large number of new users, 
configured using the ASDT and AKYD commands, then upload the file 
to the Voice Server.

• Transfer data from an old Voice Server to a new Voice Server by 
downloading user data, editing it off-line, then uploading it to the new 
Voice Server.

For more complete information on using the Clipboard, refer to its user 
documentation.

The Clipboard application (Figure 3-46) speeds system installations and 
eliminates errors by importing data from one switch to a destination 
switch. 

NOTE

NOTE

This tool is for planning purposes only and should not be construed as any legal 
definition of the number of licenses that a customer has purchased or is entitled.

REFERENCE

Download from Www.Somanuals.com. All Manuals Search And Download.



Graphical User Interface         3-43

MA4000 Installation Manager User Guide - Revision 7

Clipboard has been enhanced to be able to perform batch downloads. 
You have the ability to:

• Download data from the switch based on categories (for example, 
Station Data, Trunk Data, Restricted Data, etc.)

• Add commands the data needs to be download to a list that would be 
run as a batch process.

• Save selected commands in user template files for future access. 

This enhancement lessens the work needed when downloading data for 
the same set of commands.

 
To launch Clipboard, do the following:

Step From Microsoft Desktop, select Start > Programs > Installation 
Manager R25 > Clipboard. 
 
OR

Step From the Installation Manager Menu Bar, click Tools > Clipboard.

Figure 3-46  MAT Clipboard

Network Manager...
The Network Manager is used to manage existing networks while using 
Installation Manager to install and manage new networks.

The Network Manager application is intended to enhance the capabilities 
already present within Installation Manager, but it does not require 
Installation Manager in order to perform its task. Network Manager can 
function in a stand-alone mode and has the capability of integrating 
nodes into the Fusion (FCCS) Network whether or not the connecting 
node was originally programmed using the MAT, the Installation 
Clipboard application, or Installation Manager.

Use of this software is normally conducted as follows:

Step  1 Install NCN PBX using Installation Manager (optional).

Step  2 Install LCN PBX using Installation Manager (optional).

Step  3 Create FCCS Network using Network Manager (optional).

Step  4 Insert LCN node into existing FCCS Network using Network Manager.
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Help Menu
The Help pull-down menu is the place to go for assistance or 
information.

Help Index …
The Help Index... option displays the HTML, context sensitive help for 
the MA4000 Installation Manager application.

View Log File …
The View Log File... option lists the current MA4000 Installation 
Manager log build information. 

View User’s Guide ...
The View User’s Guide... option displays this MA4000 Installation 
Manager User Guide as a PDF.

About MA4000 Installation Manager …
The About MA4000 Installation Manager... option displays the 
application’s version and copyright information (Figure 3-47).

Figure 3-47  About MA4000 Installation Manager 

Download from Www.Somanuals.com. All Manuals Search And Download.



Graphical User Interface         3-45

MA4000 Installation Manager User Guide - Revision 7

Primary Sections

The buttons located along the left side of the graphical user interface in 
the Main window (see Figure 3-48) contain the core functions of MA4000 
Installation Manager. This is where you will view, manipulate, and 
prepare the data to be sent to the system. 

Figure 3-48  Primary Sections Tabs

When a button is selected, a tab view appears for each running 
horizontally across the top (see Figure 4-2). This information is a logical 
break down of the main button selected on the left. 

The following chapters will describe in detail every button and its 
purpose.
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4
Project Information

This chapter describes the MA4000 Installation Manager’s Project 
Information section (Figure 4-1) tabs.

Chapter Topics • Primary Contact Tab
• Company Organization Tab
• Tasks Tab
• Phased Installation Tab

Figure 4-1  Project Information Tab
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Primary Contact Tab

The Primary Contact tab (Figure 4-2) is used to provide contact 
information for a single person who will be the central point of contact 
for the entire installation. Nothing on this tab will be transferred to the 
system. It is only provided to centralize the information for the 
installation.

Figure 4-2  Project Information - Primary Contact Tab 

Company field
Enter the primary contact’s company name.

Contact field
This is the name of the individual who is the primary contact for the 
customer.
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Title field
Enter the primary contact’s title. 

Phone field
Enter the primary contact's primary phone number.

Ext field
Enter the extension, if any, of the primary contact.

Fax field
Enter the facsimile phone number for the contact.

E-Mail field
Enter the contact’s e-mail address.

Address field
Enter the primary contact person’s address. There are 3 boxes available 
for entering the full address (i.e. street, P.O. Box, building number, mail 
stop, etc.)

City field
Enter the city where the contact is located.

State field
Enter the state where the contact is located.

Zip field

Enter the zip code for the contact’s mailing address.

Country field
Enter the country where the contact is located.

Notes field
This is a free form text box allowing you to enter any information that 
maybe useful. You might want to enter a secondary contact, cell phone 
information, or other meaningful information. The field might also be a 
convenient spot to place notes concerning dates/times/outcomes of 
conversations.
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Company Organization Tab

The Company Organization tab (Figure 4-3) provides you with set 
fields allowing you to describe the company. This is usually information 
on the company where the system is being installed. 

Figure 4-3  Project Information - Company Organization Tab

Locations section
The Location section displays a tree view of the information representing 
the placement of telephone stations. The tree view can be thought of as 
an address of sorts. To locate where someone lives, the country, state, 
zip, street, and street number must be known. In the same fashion, a 
telephone station must be easily located. This section provides the 
means to break the company down into various locations. Some thought 
should be given for the logical break down of the locations where 
telephone stations will be installed. This information might be different 

Download from Www.Somanuals.com. All Manuals Search And Download.



Project Information         4-5

MA4000 Installation Manager User Guide - Revision 7

for each installation. In Figure 4-3, the locations are broken down by 
Building then by Floor. 

This information will be used in reports to help identifying locations for 
all telephone stations.

• Edit button  
 
Before the Edit button can function, an entry in the Locations tree 
view must be selected. After selecting an entry, click the Edit button. 
Figure 4-4 displays. You must close this dialog before continuing with 
any other tasks. 

Figure 4-4  Edit Location 

As shown, you are allowed to modify the entry selected.

NOTE

The maximum number of levels supported is five.
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•  New button  
 
The New button will allow you to define a new location.  
See Figure 4-5.

Figure 4-5  New Location 

If the location already exists, you will receive an error message stating 
the location exists. You will be given the opportunity to make a change 
or cancel. 
 
You have the option to add a new location and remain in the New 
Location Dialog. You simply click the OK button and the new location is 
added.
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• Delete button 
 
To use the Delete button, you must first select a branch or a leaf 
element of the tree. Clicking the Delete button will display the 
Confirmation - Delete This Item (Figure 4-6). If the user clicks the 
Yes button, the node will be removed, and any of its children.

Figure 4-6  Confirmation - Delete This Item 

Selecting the Yes button will remove the element selected, and all 
components beneath it, but will not abort the operation.

• Configure button  
 
The Configure button allows you to define the names of the levels 
within the customers organization. Figure 4-7 displays the dialog used 
to define the organization levels.

Figure 4-7  Edit Location Labels - General 
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Organization section
The Organization section allows you to define the company structure 
from an organization point of view. You can break the company down 
into departments, divisions, and groups. Its flexibility allows you to 
break items down in the best way possible.

The bottom half of Figure 4-3 displays a tree view of a defined 
organization. This tree view should closely follow the organization break 
down in a company.

• Edit button 
 
To use the Edit button, you must select a node in the tree view. When 
Edit button is clicked, Figure 4-8 displays. You will be able to modify 
the name of that node.

Figure 4-8  Edit Organization - General

If you change the Division name to a new Division name, that will 
create another division.
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• New button 
 
The New button is used to create a new entry into the company 
organization. You can define a new Division using this dialog. See 
Figure 4-9.

Figure 4-9  New Organization - General 

• Delete button 
 
You must select the element in the Organization tree view, then click 
the Delete button. Figure 4-10 displays.

Figure 4-10  Confirmation - Delete This Item 

Selecting the Yes button will remove the element selected and all 
components beneath it, but will not abort the operation.
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• Configure button 
 
The Configure button allows you to define the names of the locations 
within the customer’s buildings. Figure 4-11 displays the fields used to 
define the organization levels.

Figure 4-11  Edit Organization Labels - General 
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Tasks Tab

The Tasks tab (Figure 4-12) allows you to create a task list to manage 
items that must be completed to have a successful installation. Each 
row in the list box represents a task.

Figure 4-12  Project Information - Tasks Tab 
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• Edit button
In order to use the Edit button, a task must be selected. The Edit 
button will allow you to modify a task. Figure 4-13 displays a task 
being edited.

Figure 4-13  Edit Task 

Selecting the Browse button for the Begin Date, Due Date, or Complete Date fields 
causes an Edit Date dialog box (Figure 4-14) to appear. Use this pop-up calendar to 
select the appropriate date for each field.

NOTE
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Figure 4-14  Edit Date - General
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• New button
The New button will add the current information to the task list. Click 
the New button, and Figure 4-15 displays. 

Figure 4-15  New Task - General

Once a task has been added, the status selected (Open, Started, 
Testing, or Closed), and the Begin, Due, and Complete dates 
chosen, click the OK button to return to the Tasks Tab.  

• Delete button
The Delete button removes the current task from the task list. See 
Figure 4-16. 

Figure 4-16  Confirm Delete - Delete The Current Selected Task(s) 
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Phased Installation Tab

The Phased Installation tab is intended for advanced users only!

The Phased Installation tab (Figure 4-17) allows the Installation 
Manager (IM) to add additional user station data, MG devices, and 
Circuit Cards to an existing Voice Server database. The user can install 
the Voice Server data in different phases. The user and circuit card 
assignments can be assigned to different phases. The other basic data 
(access code, numbering plan, etc.) are for Phase 1 only.

Phased installations are intended for larger installations or Voice Server 
conversions projects that must be implemented in distinct stages over a 
period of days or weeks. Phased installation differs from a standard 
installation in the fact that during a phased installation Installation 
Manager will synchronize with the Voice Server and reconcile any 
problems before uploading new data to the Voice Server.

If you do not turn on the phase feature, all functions act as they did with 
the previous version of Installation Manager.

CAUTION
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Figure 4-17  Project Information - Phased Installation Tab
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• Edit or New button 
When the Edit or New button is clicked, Figure 4-18 displays.

Figure 4-18  Phased Installation - New or Edit Button

— Enter the appropriate information, as needed, in the Description 
and Notes fields.

— After uploading the data, the corresponding phase will be marked 
as Date Committed. The check box can be cleared to resume the 
same phase data upload again.

Once a phase is uploaded, Installation Manager marks the phase as committed and 
enters the date that the phase was uploaded. Remember, this does not mean the 
phase data has been uploaded to the switch.

NOTE
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5
Hardware Information

This chapter describes the MA4000 Installation Manager’s Hardware 
Information section tabs (see Figure 5-1).

Chapter Topics • Options Tab
• Media Gateway and Circuit Cards
• Voice Mail Tab
• Security Tab

Figure 5-1  Hardware Information Tab 
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Options Tab

Use Figure 5-2 (Options Tab) to configure miscellaneous system options.

Figure 5-2  Hardware Information - Options Tab 

Project Name field
This is the name of the project database. You can change the database 
name, but is recommended it remain as the name of the database. This 
field is used in many reports to identify the installation the data is 
associated with.

System Type field
Valid choices are NEAX IPX, NEAX IPX DM, UNIVERGE IPX, UNIVERGE 
SV7000, NEAX IPX UMG, and UNIVERGE SV8500.
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Dual CPU check box 
Select to identify when redundant SV8500 and SV7000 T10 processors 
are used.

Dual Time Division check box
Select to identify when redundant SV7000 T10 processors are 
multiplexing. 

6 Unit (6U) Physical Chassis check box

• Checked - Indicates 6U Physical Chassis’s are to be used. 

• Unchecked - Indicates 9U Physical Chassis’s are to be used

SV8500 does not support 6U chassis configuration.

System Options section
This section determines how the system will be programmed, and what 
commands will be used. It is used in reporting and consists of:

• Fusion - Use the Fusion drop-down menu to specify the type of 
Fusion network to which your system will connect. The option is not 
available on SV7000 MPS. Select one of the following:
— NCN - Network Control Node (Fusion Network NCN) 
— LCN - Local Control Node (Fusion Network LCN) 
— Standalone - NEAX IPX/IPX DM or UNIVERGE IPX only

• Fusion Point Code (LCN Only)
If the system is to be an LCN in a Fusion Network, select an 
appropriate Fusion Point Code. It is useful to provide a technician this 
information so the system can be configured to support these 
features.

• Attendant 
— Access to Attendant (Operator Call) - This is the number of the 

company’s operator. This number will be referenced in several 
areas as a macro. It is used heavily in templates such as Call 
Forwarding.

— Use Monitored Number as Attendant
• System Name field

This is the name of the system. This information will be assigned 
internally to the system.

NOTE

NOTE
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• IP Phone Type field
Allows specification of the IP Phone support needed in MA4000 
Installation Manager. This setting determines what options are made 
available in other areas of MA4000 Installation Manager. 

Example: If there is no IP Phone support needed, you will not have the 
option of viewing IP Phone Models in the Phone Model List on 
the User Edit Dialog.

The IP Phone Type options will consist of a combination of the 
following: 
 
TDM 
Requires a PIR. Time Division Multiplex phones are NEC non-IP, circuit 
card based Dterm or analog phones.
IP P-P 
IP Peer-to-Peer phones are NEC IP phones not requiring circuit cards.
SIP 
Session Initiated Protocol are NEC or other vendor IP phones which 
conform to SIP standards. 

• Name Display and Name Display Length fields
Specify in the Name Display and Length fields the default format for 
users with phones having Name Display support.

Connect Type section
This section allows you to specify the communication interface used to 
connect to the system.

• TCP/IP option
— Address - IP address of the SV7000 T10 or IPX
— Port - 60000 

• Direct option (requires serial cable and is not used for SV7000)
— Comm Port - Serial COM port of the PC which the MA4000 

Installation Manager is operating on.
— Baud Rate - Default value is 4800
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User ID and Password fields (optional)
The User ID and Password fields can be used if authentication is 
required. 

Test button
Clicking the Test button performs a verification of the system 
connection selected. If the test connection fails, Figure 5-3 displays.

Figure 5-3  Test Connection - Login Failed 

Setup IP... button
Clicking the Setup IP ... button allows the user to configure the active 
and standby IP addresses, subnet mask, default gateway, speed, duplex 
mode, and the ARP broadcasting period (no send, 30 sec., 60 sec., or 
120 sec.), if applicable. The user identification and backup IP passwords 
can also be activated. See Figure 5-4 (UNIVERGE SV8500 example), 
Figure 5-5 (UNIVERGE SV7000, UNIVERGE IPX, NEAX IPX, and NEAX 
IPX DM example), and Figure 5-5 (NEAX IPX UMG example). 

NOTE

The following options can only be used after the software has been successfully 
installed and the system is online.

NOTE

If the Backup IP/Password Settings option is selected, Installation Manager will 
back up the SV7000 after configuring the IP address and password.

For the IPX, the Backup IP/Password Setting is not available. Instead, there is a 
Total PIMs (Physical +Virtual) field. 

The IPX Installation Manager will automatically perform a System Backup and then 
reset the Voice Server, after the IP address and password are configured.
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Figure 5-4  Edit IP Configuration - UNIVERGE SV8500 Example
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Figure 5-5  Edit IP Configuration - UNIVERGE SV7000 and IPX, NEAX IPX, and NEAX IPX DM Example
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Figure 5-6  Edit IP Configuration - NEAX IPX UMG
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Media Gateway and Circuit Cards

The Media Gateway and Circuit Cards (Figure 5-7) tab is where 
peripheral devices (i.e, VS-32, MG-PRI, MG-COT, MC-2A), Protocol 
Handlers, and Circuit Cards are assigned and configured. By default, all 
of the required protocol handlers will be automatically assigned, no user 
configuration is required.

Figure 5-7  Hardware Information - Media Gateway and Circuit Cards Tab

The Setup button is disabled for the SV8500 SIP Server setup.

When installing a peripheral device, the MA4000 Installation Manager 
will both configure the SV7000 and separately the peripheral device. To 
configure a peripheral device, a serial cable is required to connect the 
MA4000 Installation Manager PC to the device.

NOTE
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Figure 5-8  Female DB9 to Female DB9 Straight Through Cable example

New button
Clicking the New button displays the New Circuit Card dialog 
depending on the IP server. See the Figure 5-9 and Figure 5-10 
examples. 

Figure 5-9  New Circuit Card - IPX Example
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Figure 5-10  New Circuit Card - UNIVERGE SV8500 Example

Select the Media Gateway or circuit card to be assigned. Figure 5-11 is 
an example of the dialog box that displays when selecting the Media 
Gateway - MG 1.5M card.

Download from Www.Somanuals.com. All Manuals Search And Download.



5-12         Hardware Information

MA4000 Installation Manager User Guide - Revision 7

Figure 5-11  Example - Media Gateway - MG 1.5M Edit Circuit Card

Depending on the system type selected, some of the options will install 
automatically and will not need to be selected.

The following options require a PIR:

• Attendant Console
• PAD
• Physical
• Station
• Trunk

Delete button
Highlight the circuit card to be removed and click the Delete button. 
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Edit button
Edit the circuit card selected, changing the fields as needed. When you 
are satisfied with the changes made, click the OK button to save the 
changes.

Circuit Card Field Definitions

Access to Attendant Operator The code system users dial to 
reach the attendant.

ANNC Equipment# Specifies what the announcement 
is to be used for. For Music On 
Hold, choose 64-MOH-IP Ext 
Hold Tone.

ANNC Pattern (ANP) A .wav or .mdt-type file. Enter a 
three digit number from 000 - 
255. This number correlates to an 
existing .wav file loaded in the 
VS32, that you wish to be played 
for the defined ANNC Equipment 
#.

Connection Duration Indicates how long a caller will 
remain connected (0 - Disconnect 
after 30 seconds; 1 - Remain 
connected until the caller 
disconnects).

Count The number of the route that will 
be created for this device

DC The number of digits to be 
translated for incoming calls. 
Typically, this would be set for the 
number of digits in the station 
numbers.

Default Gateway Address The IP address of your network's 
gateway router.

Do Not Send RingBack Tone Selecting this option box prevents 
sending a RBT.

DRS Address The IP address of the Device 
Registration Server.

Hardware Type Media Gateway: MC4A/MG-2A/
MC4MG2/SCA-4LCOTA

MG 1.5M: SCA-24PRIA/SN8032/
SN8110

IP Address The Internet Protocol address for 
the equipment.

Download from Www.Somanuals.com. All Manuals Search And Download.



5-14         Hardware Information

MA4000 Installation Manager User Guide - Revision 7

Installation Phase The phase the device intends to 
install.

Kind The PRI trunk type selected from 
the pull-down menu (NI-2, AT&T 
- 41459, and DMS - Nortel 
A211).

MAC Address The Media Access Control address 
for the equipment. The address is 
located on the bottom of the 
equipment.

Name (Description) Circuit card name.

Network Mask A string of 0's and 1's that mask 
or screen out the network part of 
an IP address (IP) so that only 
the host computer part of the 
address remains.

Number of Attendants Consoles The number of attendant consoles 
the system contains.

Operate Unit in SIP Mode Initiates an interactive user 
session that involves multimedia 
elements such as video, voice, 
chat, etc. 

REGMAX The registration assignment 
capacity (1-6144). This maximum 
should not exceed the line 
capacity of the system. Default is 
256.

Repeat Pattern Indicates the sequence of the 
announcements the caller should 
hear. 

Route Name Note. This field can only be 
modified if the Service Type is 
ANNC.

Route Restrictions (RSC) The restriction classes in the 
system. 

Send Answer Signal Indicates whether Answer 
Supervision should be sent when 
an incoming Trunk connects to an 
Announcement.

Service Feature Restrictions (SFC)The service feature classes built 
into the system.

Service Type How the channel is to be used. 

Signal Ch. Route Name The Media Gateway circuit card’s 
signal channel route name.

Station Number The number of an available 
station number conforming to the 
numbering plan.
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Media Gateway Setup button

• Setup button

Step  1 Configure a Media Gateway device by highlighting a predefined Media 
Gateway and clicking the Setup button. Figure 5-12 displays.

Figure 5-12  Media Gateway Setup Wizard - Welcome

Step  2 Click the Next button to proceed. Figure 5-13 displays.

IMPORTANT

Before a Media Gateway device can be configured using the Setup button, a One-
time Password needs to created. Please refer to the Security Tab section of this 
chapter to set the password. 
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Figure 5-13  Media Gateway Setup Wizard - Select Operation

Step  3 Select the appropriate Comm Port, Properties, Speed, and Duplex 
Mode, you wish the operation to perform, enter the Default Gateway, if 
applicable, and then click the Next button. Figure 5-14 displays.

The option buttons located beneath the Speed and Duplex Mode sections display 
the current selection of Media Gateway hardware type. They are:

• Media Gateway - MG 1.5M
• Media Gateway - MC-4A/MG-2A/MC4MMG2/SCA-4lCOTA 

Example: SCA-24PRIA, SN8110, and SN8032 all belong to the MG 1.5M hardware 
family. Each has a different capacity or firmware.

NOTE
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Figure 5-14  Media Gateway Setup Wizard - Select Values 

Step  4 Update the values before continuing.

Step  5 Connect a serial cable from the COM port on the PC to the RS232C 
connector on the Media Gateway unit. 

Step  6 When all the values are updated and correct, click the Next button. 
Figure 5-15 displays.
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Figure 5-15  Media Gateway Setup Wizard - Setting Media Gateway 

Step  7 When the Media Gateway setup is complete, Figure 5-16 displays.
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Figure 5-16  Media Gateway Setup Wizard - Operation Completed 

Step  8 Click the View Log button to see a list of the operation results.

Step  9 Click the Finish button to exit the Media Gateway Setup Wizard.

Signaling Server - SIP Server (Including MPH)

The Signaling Server is enabled when:

• System Type = SV7000 UNIVERGE
• Fusion = NCN - Network Control Node 

SV

UNIVERGE SV8500 is not supported.

The Signaling Server option (Figure 5-17) allows you to define ranges 
for the SIP Server. The signaling server helps establish, modify and 

NOTE

NOTE
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terminate IP-base calls. You can use Installation Manager to set basic 
signaling server communication parameters.

Figure 5-17  Hardware Information - Signaling Server Tab 

For the UNIVERE SV8500, the LMG, Time Zone, and DNS IP Address fields do not 
display.

IMPORTANT

Information entered in the fields on the Signaling Mail tab are for Phase 1 
installations only.

NOTE
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Name (Description) field
Enter a server description, or use the default shown.

Signaling Server ID field (This name must be unique on the NEAX IPX 
UMG)
Enter the Signaling Server’s ID, or use the default value of 1.

Speech Channels field
Enter the appropriate number of channels, or use the default value of 0.

LMG field (UMG System Only)
Enter the Local Module Group total (0 - 3).

New IP Address field
Enter the Signaling server’s new IP address.

Network Mask field
Enter the Subnet Mask for the Signaling Server's IP Address.

Gateway field
Provide the Gateway’s address for routing.

MPH ID field (This name must be unique on the NEAX IPX UMG)
Enter the Multi Protocol - MPH ID, or use the default value of 1.

Time Zone field
Select the applicable time zone.

DNS field
Enter the DNS Data (Signaling Server) address or name. If using the 
address format, enter the Signaling Server's IP Address (same as the 
'New' IP Address field).

Domain Name field (This name must be unique on the NEAX IPX UMG)
Supply the network system’s domain name for the Signaling server, or 
use the default UNIVERGE_SV_7000.COM.

Installation Phase field
Specify the phase in which the signaling server data will be uploaded to 
the server. (Phased installations only).
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Voice Mail Tab

The Voice Mail tab (Figure 5-18) allows you to set and configure 
information used to link a user to a voice mail system. The Voice Mail 
tab will provide information to the MA4000 Installation Manager on how 
it can connect to the voice mail system. Any detailed customizing will 
require a technician to use existing maintenance interfaces to 
completely set up the voice mail system.

Figure 5-18  Hardware Information - Voice Mail Tab 

IMPORTANT

Information entered in the fields on the Voice Mail tab are for Phase 1 installations 
only.
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Voice Mail System

Voice Mail Type field
The available options are <None>, NEAXMail AD-64, UNIVERGE 
UM4730, UM 8500 SQL Message Store, UM8500 Exchange Message 
Store, and <Other Voice Mail>. 

Port Type

NEAXMail
AD-64

UNIVERGE
UM4730

UM8500 
Exchange 

Message Store

UM8500 
SQL 

Message Store
Other 

Voice Mail

MCI - 
Analog Station X X X X

MCI - 
Line Side T1 X X X X

Digital 
Integration 

(Dterm Ports)
X X X X

Digital IP 
Integration X X X

Address field
Specifies the IP Address of the voice mail system for administration.

User Name field
This is the administrator user name configured on the voice mail 
system.

Password field
This is the administrator’s password on the voice mail system.

Pilot Number field
This is the pilot number of the hunt group for the voice mail system. 
This will be used for the voice mail macros in Key Button templates, 
{VoiceMail}. This field is determined by the first entry listed in the 
Voice Mail Station Ports field.

Test Voice Mail Connection button
Clicking the Test button performs a verification of the Voice Mail System 
connection.

NOTE

The Test button can only be used by the UNIVERGE UM4730 after all Voice Mail 
Ports have been programmed and the UNIVERGE UM4730 is on-line.
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Exchange Information

Server field
This is the Microsoft Exchange server name. Example: Mailbox Store.

Mailbox Store
The Mailbox Store (similar to group) where the mailboxes were created. 
Example: First Storage Group.

Active DIrectory Information

Domain
The active directory domain name. Example: cantonad120.com.

Container
The container name where users are added. Example: Users.

Voice Mail Station Ports

New button
When the New button is clicked, Figure 5-19 displays.

Figure 5-19  Edit Voice Mail Port
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Enter the applicable station number and the phone name to be 
displayed. Select the Route Restrictions and Service Restrictions (use 
the default, or create a new configuration) from the Route 
Restrictions (RSC) and Service Restrictions (SFC) drop-down 
menu. A port can also be removed by clicking the Delete Port button.

Edit button
Select the port to be edited and click the Edit button. A display similar 
to Figure 5-19, containing the information for the selected port, 
appears.

Delete button
To delete a specific port, select the port and click the Delete button. 
Click the OK button to verify deletion of the port.

Move Up and Move Down buttons
Use the Move Up or Move Down buttons to arrange the sequence of 
each port.
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Security Tab

The Security tab (Figure 5-20) allows you to set and configure a one-
time password that will prevent unauthorized access to the SIP 
terminal/equipment. 

Figure 5-20  Hardware Information - Security Tab
 

NOTE

The following equipment are compatible with the one-time password authentication:

• Media Converter - MC* (8 Port Analog)
• Media Gateway - PRI (SP-3884, Issue-5A or later)
• DtermIP(SIP) (1.4.3.0 or later)
• VS32-V (SP-3901)

IMPORTANT

Information entered in the fields on the Security tab are for Phase 1 installations 
only.
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Terminal/Equipment Security

One-Time Password field
The one-time password is a disposable password that can be used only 
one time. The password becomes invalid when the time period indicated 
in the One-Time Password Expires field is exceeded. If the system is 
initialized or the effective timer expired, the password will need to be 
reassigned. Passwords must be 4 to 10 digits in length, consisting of the 
characters 0 through 9, the * sign, or the # sign.

Expires field
The options available are Never, 1 hour, 8 hours, 24 hours, 2 days, 3 
days, 4 days, 5 days, 6 days, or 7 days.

Terminal Encryption field
The options available are Partial Data Encryption or Full Data 
Encryption.

Terminal Authentication field
The options available are Disabled or Enabled.
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6
System Information

This chapter describes the MA4000 Installation Manager’s System 
Information section tabs (see Figure 6-1).

Chapter Topics • Station Ranges Tab
• Access Codes Tab
• Speed Calling Tab

Figure 6-1  System Information Tab 
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Station Ranges Tab

The Station Ranges tab (Figure 6-2) allows you to define ranges for 
various types of phone extensions and to also reserve numbers so the 
tool will not automatically be assigned to those ranges.

Figure 6-2  System Information - Station Ranges Tab 
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Station Range section
The Station Range section lists all the station ranges that have been 
defined.

• Edit button
You must first select a record in the Station Range list, then click the 
Edit button. Figure 6-3 displays allowing you to modify the entry 
selected. 

Figure 6-3  Edit Station Range - General

Description field

The Description field is any description you want to use to identify the 
Station Range. It is used for informational purposes when assigning 
users. On the basis of ranges assigned here, and applied in the user 
assignment dialog, the MA4000 Installation Manager will automatically 
assign an unused station number from the appropriate range. 
 
Station Range section
The Station Range fields contain the defined range.

Subline section
The Subline is used to assign an offset value, a group of numbers that 
will be allocated for use as sublines. The offset value can be a negative 
value.
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Office Code section
The Area / Office Code field allows you to specify the Telco 
information associated with the range of station numbers. 

Select the OK button to accept the changes, or the Cancel button to 
ignore the modifications specified.  

• New button 
 
The Station Range New button allows you to define a new Station 
Range. See “Edit button” on page 6-3 for a complete explanation of all 
the fields available. 

• Delete button 
 
You must first select a row in the Station Range list, then click the 
Delete button to remove the record. Figure 6-4 displays asking you 
whether or not you want to delete the selection. 

Figure 6-4  Warning - Delete Station Range(s)

Reserved Stations section
The Reserve Stations section allows you to instruct the MA4000 
Installation Manager not to automatically assign users to specific 
numbers or sets of numbers. A good example would be for voice mail 
systems and operators. Extensions to these items are generally 
manually assigned to maintain commonality with a previous system, or 
to make the extensions easy to remember.

Later in the Users section, there is the ability to manually assign a user 
to a specific extension. The user’s name will be inserted into the Reserve 
Station list, removing the number from the pool of extensions available 
for automatic assignments.

• Edit button 
 
You must first select a row then click the Edit button. Figure 6-5 
displays providing you the ability to edit the selected record.
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Figure 6-5  Edit Reserved Stations - General
 

Description field
Enter a meaningful description of the range being defined.

Station Range section
Enter the range of extensions to be reserved. If it is a single number, 
then set the From and To fields to the single number. The From 
number must be less than the To number.

Select the OK button to accept the changes, or the Cancel button to 
ignore the modifications specified.  

• New button
The Reserved Station Range New button allows you to define a new 
Reserved Station Range. See “New button” on page 6-5 for a 
complete explanation of all the fields available. 

• Delete button 
 
You must select a row in the list, then click the Delete button. Figure 
6-6 displays asking you whether or not you want to delete the 
selection.
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Figure 6-6  Warning - Delete Reserved Station Range(s)
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Access Codes Tab

Special Access Codes allow access to additional system-wide features 
that may not exist on individual telephones. This feature may be 
restricted using the Service Feature Restrictions (SFC) settings. See 
Figure 6-7.

Figure 6-7  System Information - Access Codes Tab

When the Edit or New buttons are selected, Figure 6-8 displays.

IMPORTANT

Information entered in the fields on the Access Codes tab are for Phase 1 
installations only.
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Figure 6-8  Edit Access Code

Step  1 Select the desired feature for the new or edited access code from the 
Feature Description drop-down field.

Step  2 Enter the code to be used for this feature in the Access Code field.

Step  3 If editing an existing feature, click the OK button to accept the changes. If 
this is a newly defined feature, click the New button to create the feature.

Step  4 You can remove a feature either by selecting it from the Access Codes 
tab, or the Edit Access Code window, and clicking the Delete button.
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Speed Calling Tab

The Speed Calling feature allows a user or attendant console to call 
frequently dialed numbers using fewer digits (Abbreviated Call Codes) 
than normally required. This feature may be restricted using the Service 
Feature Restrictions (SFI-12) settings. See Figure 6-9. 

Figure 6-9  System Information - Speed Calling Tab

The options available are No System Speed Calling, 2 Digit System 
Speed Calling, and 3 Digit System Speed Calling.

When the Edit or New buttons are selected, Figure 6-10 displays.

IMPORTANT

Information entered in the fields on the Speed Calling tab are for Phase 1 
installations only.

NOTE

To be able to access System Speed Calling, a System Speed Calling key must be 
assigned to the Dterms, or a System Speed Calling Access Code must be assigned.
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Figure 6-10  Edit System Speed Calling

Step  1 Enter the desired number in the Speed Calling Number field (a 
maximum of 24 digits).

Step  2 Enter the code to be used for this feature in the Abbreviated Call Code 
field.

Step  3 If editing an existing feature, click the OK button to accept the changes. If 
this is a newly defined feature, click the New button to create the feature.

Step  4 You can remove a feature either by selecting it from the Speed Call tab, 
or the Edit System Speed Calling window, and clicking the Delete button.
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7
Advanced Features

This chapter describes the MA4000 Installation Manager’s Advanced 
Features section tabs (see Figure 7-1).

Chapter Topics • System Features (ASYD) Tab
• Feature Restrictions Tab
• Route Restrictions Tab
• Least Cost Routing (LCR) Tab
• Automated Call Distribution (ACD) Tab
• Open Application Interface (OAI) Tab
• Monitor Number Tab

Figure 7-1  Advanced Features Tab
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System Features (ASYD) Tab

The System Features (ASYD) tab (Figure 7-2) defines the ranges of 
station numbers the Installation Manager will use to assign phone 
numbers to users. Also, the feature allows administrators to designate a 
range or numbers that will not be assigned to users.

Figure 7-2  Advanced Features - System Features Tab

Your system, in its initial state, contains no configuration information 
and must be loaded with data which lets the CPU recognize the system 
type and configuration. The ASYD commands assign values for data 

IMPORTANT

Information entered in the fields on the System Features (ASYD) tab are for Phase 
1 installations only.

IMPORTANT

This tab is intended for advanced users only.
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memory (DM), local data memory (LDM), and network data memory 
(NDM) (see Figure 7-3). By default, Installation Manager supplies initial 
values for these necessary parameters and uploads them to the CPU 
during the installation process.

Experienced users can alter these values, as well as delete or create 
new commands. Be aware that deleting required values may cause your 
system to be non-functional. For complete information on using ASYD 
commands to configure Voice Server features, consult the Office Data 
Specifications Manual.

Data for each index is entered in hexadecimal format (00 to FF).

Example: Data = 19. Bit 0, 3, and 4 are set.

Example:

Each bit (in binary, 0 to 1) has its own unique meaning. Refer to the 
Office Data Specifications Manual for details.

To use the default features, select the Use Default System Features 
check box. Restore the default settings by clicking the Restore 
Defaults button.

When the Edit or New buttons are selected, Figure 7-3 displays.

Figure 7-3  Edit System Features

Step  1 Select the desired command (ASYD, ASYDL, and ASYDN) from the 
Command drop-down field.

NOTE

These buttons are only enabled when the Use Default System Features option is 
not selected.
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Step  2 Enter the appropriate information to the System, Index, Data, Bit, and 
Note fields. The information contained in the Data field is in hexidecimal 
format.

Step  3 If editing an existing feature, click the OK button to accept the changes. If 
this is a newly defined feature, click the New button to create the feature.

Step  4 You can remove a feature either by selecting it from the Systems 
Features (ASYD) tab, or the Edit System Features window, and clicking 
the Delete button.

Deleting a selecting System Feature record does not disable the selected feature, 
but, instead, restores the original System Default settings. 

To disable a feature refer to the Office Data Specification Manual.

 

Step  5 Use the Cancel button to return to the Systems Features (ASYD) tab 
without making any editing changes.

NOTE
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Feature Restrictions Tab

Information entered in the fields on the Feature Restrictions (ASYD) tab are for 
Phase 1 installations only.

The Feature Restrictions tab (see Figure 7-4) allows you to provide 
meaningful names to the Service Feature Classes built into the system. 
It is anticipated that as installation personnel use MA4000 Installation 
Manager, they will develop default templates that are used for the 
majority of their customers and end users. This feature defines and 
selects system-wide features and, optionally, allows you to enable or 
disable them using day/night modes.

There are 16 Route Restriction Classes (RSC) and 16 Service Feature 
Classes (SFC) available on your system. You can use Route Restriction 
Classes to prevent, for example, lobby phones from making outgoing 
calls. You can use Service Feature Classes to assign a group of phones a 
Class of Service feature, such as providing call forwarding for all guest 
phones.

Your system, by default, lists each restriction class with a numeric code, 
such as RSC-0. Installation Manager lets you create meaningful text 
descriptions for each level, such as "Guest Phone RSC-0", making it 
easier to administer and maintain restriction classes.

You can use the Restrictions tab to enable or disable individual classes, 
and to specify whether they apply to Day or Night service, or both. You 
can also specify whether route restrictions should apply to incoming/
outgoing attendant or direct-dialed calls.

IMPORTANT
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Figure 7-4  Advanced Features - Feature Restrictions Tab

• Edit button
When you select a Service Feature Class, then click the Edit button, 
Figure 7-5 initially displays.
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Figure 7-5  Edit Service Feature Restrictions (SFC) - Day Tab

You are then allowed to provide a description of the SFC number 
selected, and the service features to be assigned to the SFC number. 

— Selecting the Use Default Service Features check box limits the 
service features to those features annotated with a check mark in 
the list.

— Selecting the Only Show Selected Features check box allows 
you to only display those features chosen for that particular SFC 
number.

— Clicking the Clear All button will remove all previously selected 
service features for the listed SFC number.

When the Night tab is selected, Figure 7-6 displays.
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Figure 7-6  Edit Service Feature Restrictions (SFC) - Night Tab

— Selecting the Allow Day and Night Service Feature 
Restrictions check box allows the service feature restrictions to 
be available day or night.

— Selecting the Use Default Service Features check box activates 
the default service features.

— Selecting the Only Show Selected Features check box allows 
you to only display those features chosen for that particular SFC 
number.

— Clicking the Clear All button will remove all previously selected 
service features for the listed SFC number.
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Route Restrictions Tab

Information entered in the fields on the Route Restrictions tab are for Phase 1 
installations only.

There are 16 Route Restriction Classes (RSC) and 16 Service 
Feature Classes (SFC) available on your system. You can use Route 
Restriction Classes to prevent, for example, lobby phones from 
making outgoing calls. You can use Service Feature Classes to assign 
a group of phones a Class of Service feature, such as providing call 
forwarding for all guest phones.

Your system, by default, lists each restriction class with a numeric code, 
such as RSC-0. Installation Manager lets you create meaningful text 
descriptions for each level, such as "Guest Phone RSC-0", making it 
easier to administer and maintain restriction classes.

You can use the Route Restrictions tab to enable or disable individual 
classes, and to specify whether they apply to Day or Night service, or 
both. You can also specify whether route restrictions should apply to 
incoming/outgoing attendant or direct-dialed calls.

The Route Restrictions tab (Figure 7-7) defines criteria which 
determine how a call will be handled when originating or terminating 
over a specified route. The feature also lets you specify different 
restrictions when your server operates in day or night mode. It is 
utilized to define templates that will be used for each phone to describe 
the characteristics of each user’s phone. It specifies templates for those 
users who have access to the rich features of the system.

IMPORTANT

NOTE

The routes are defined in the Hardware Tab using the Media Gateway definitions 
located in the Media Gateway and Circuit Cards Tab.
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Figure 7-7  Advanced Features - Route Restrictions Tab 

The Route Restrictions (RSC) (see Figure 7-7) provides a list of 
restriction classes in the system. The list is provided as an 
enhancement. It allows the MA4000 Installation Manager user to name 
the 16 available restriction templates (classes) with a meaningful name. 

• Load Default Route Restrictions Data check box
(Optional) Click the Load Default Route Restriction Data check 
box to instruct your system to use pre-programmed default routes.

• Allow/Restrict All Data check box

NOTE

Media Gateway circuit cards listed in the Routes section are created using the 
Media Gateway and Circuit Cards section of the Hardware Information tab. See 
“Media Gateway and Circuit Cards” on page 5-9.

NOTE

Installation Manager will program ANY class that is assigned to a station. If only 
RSC-1 is assigned, then that is the only class programmed. But if all 16 classes are 
assigned to the various phones, then Installation Manager will program all 16 
classes, etc.

Classes that are assigned a Description but are not assigned to a phone will not be 
programmed by Installation Manager.
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(Optional) Click the Allow/Restrict All Data check box to instruct 
your system whether to allow or restrict Attendant Incoming, 
Attendant Outgoing, Direct Incoming, or Direct Outgoing Calls.

• RSC Edit button
When you select a Route Restriction Class, and click the Edit button, 
Figure 7-8 displays. You are then allowed to assign a class name and a 
detailed description for that class. 

Figure 7-8  Edit RSC - Day Tab 

— The RSC Number field displays the RSC selected for editing, while 
the Description field provides you the opportunity to enter a more 
descriptive label, if desired.

— The Route field displays the Media Gateway circuit the RSC being 
edited is located.

— The Alt Incoming, Alt Outgoing, Direct Incoming, and Direct 
Outgoing drop-down fields allow selection of either the Allowed 
or the Restricted options for those features. The Direct Outgoing 
drop-down field also allows the selection of the Toll option.

When the Toll option is selected, the Toll section located below the RSC section 
becomes active allowing editing. 

Figure 7-9 displays when the Night tab is selected.
NOTE
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Figure 7-9  Edit RSC - Night Tab
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• New Toll button 
 
Select a Route Restriction Class, and click the New button, Figure 7-
10 displays. 

Figure 7-10  Edit Toll - Outgoing Connection - Day Tab

— The Restriction drop-down field allows selection of either the 
Restricted, Allowed, 3/6 Toll Restriction, or Operator 
restrictions.

Figure 7-11 displays when the Night tab is selected.
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Figure 7-11  Edit Toll - Outgoing Connection - Night Tab

— Using the Day tab, when the 3/6 Toll Restriction option is 
selected, Figure 7-12 displays.
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Figure 7-12  Edit Toll - Outgoing Selection

— Selecting the Add button displays Figure 7-13.
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Figure 7-13  Edit Route Toll Restriction

— Enter the destination and whether their is a restriction or not.
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Least Cost Routing (LCR) Tab

Information entered in the fields on the Least Cost Routing (LCR) tab are for Phase 
1 installations only.

Use the Least Cost Routing (LCR) tab (Figure 7-14) to configure the 
server to route calls over the most economical facility available, such as 
WATS lines, foreign exchanges, or direct dial lines. Based on the area 
code and office code entered, the system refers to the programming 
tables which determines, in order, the most economical route for the 
call. 

Using Installation Manager, you can configure your system to use a 
supplied set of default LCR routes, edit them to your own requirements, 
or create new routes. You can also specify conditions (or number 
patterns) that determine when the routes will be used, as well as certain 
times of day when they are in effect.

Figure 7-14  Advanced Features - LCR Tab

IMPORTANT
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You can enable the Least Cost Routing by deselecting the Load 
Default LCR check box.

Step  1 Choose the LCR number to be programmed and select the Edit button. 
Figure 7-15 displays. 

To create a new LCR entry, select the New button.

Figure 7-15  Edit System Features

Step  2 Enter the Call Pattern information. The system will then use this pattern 
to match a user's dialed digits and invoke LCR for the call.

Step  3 Select the number of digits from the Maximum Necessary Digits drop-
down field that the system will scan. The Maximum Necessary Digits 
number is the number of digits (from left to right) the system waits before 
sending a call for further processing. If the number contains fewer than 
the Maximum Necessary Digits, the system waits as follows:

—Interdigit Timeout (typically 10 seconds) x the missing digits number
—For example, if the Maximum Necessary Digits is 12 and the system 

receives 10 digits, it waits 2 x 10 = 20 seconds before processing the 
call.  
 
2 (numDigits missing) x 10 (interdigit timeout) = 20 

NOTE
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At this point, the user may need to configure a local or network pattern. 
If so, the user can optionally specify whether the LCR is invoked only 
during certain time periods. The user must specify the number of digits 
(in the dialed stream) the system will strip out (digits to skip). For 
example, deleting 9 and 1 for a long distance call. The system looks at 
digits from left to right and begins stripping “on the left”. 

Step  4 Choose the desired option from the following drop-down fields:

—Local Pattern (for CCIS): Local Pattern 1, Local Pattern 2, Local 
Pattern 3, None, or New. This option specifies the sequence of routes 
a call matching the pattern will use. You can use an existing pattern or 
create your own.

—Network Pattern (for all other trunks): Network Pattern 1, Network 
Pattern 2, Network Pattern 3, None, or New. This option also 
specifies the sequence of routes a call matching the pattern will use. 
You can use an existing pattern or create your own.

—When the Browse button located next to the Local Pattern (for CCIS) 
or Network Pattern (for all other trunks) is selected, Figure 7-16 
displays.

Figure 7-16  Edit Least Cost Routing Pattern

Step  5 The Time of Day field allows the user to define the time of day patterns. 
Select the Browse button located next to the Time of Day field. Figure 
7-17 displays.
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Figure 7-17  Edit Time of Day Patterns
  

—Enter the desired time sequences, not to exceed 24 hours. 

Step  6 To edit a circuit card’s routing, choose a circuit card (or cards) listed in 
the Route field and use the Right Arrow button to move the card to the 
editing section.

Step  7 To edit a specific card, choose the card and select the Edit button. Figure 
7-18 displays.
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Figure 7-18  Edit Least Cost Routing Data

Step  8 Using the Number of Digits to Skip field, the user must specify the 
number of digits (in the dialed stream) the system will strip out (or digits 
skipped). For example, deleting 9 and 1 for a long distance call.

—The system looks at digits from left to right and begins stripping on the 
left. 

Step  9 Specify whether the user will hear an overflow tone if all lines in the 
selected trunk are full using the Overflow Tone field. 

Step  10 Use the Digits to Add field to enter a number that will be added at the 
beginning of the number sequence. For example, if the Number Of 
Digits To Skip Number is 5, and the Digits To Add number is 214, then 
a starting number of 91817-479-9986 would be translated to 214-479-
9986.

—When the Browse button next to the Digits to Add field is selected, 
Figure 7-19 displays.
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Figure 7-19  Additional Digit Translation (AADC)

Step  11 Enter the additional digits and select the OK button.

Step  12 Select the Priority Restriction Class.

Step  13 Use the Kind of Trunk field to specify whether the trunk is IP or non-IP. 

Step  14 If IP was selected, use the Point of Code field to set the point code.

Step  15 The configured route now appears on the list. It can be moved up or 
down, which determines the sequence in which the calls attempt to find a 
trunk. For example, a call matches the LCR pattern, then attempts 
completion using the first trunk listed. If that is full, it then goes to the next 
trunk and so forth. Each choice is less desirable than the preceding one.

Step  16 Use the Toll Code Identification field to specify whether the call should 
be identified as a toll call or local call.

Step  17 Use the Account Number field to specify whether an account number is 
necessary to access the selected trunk in the LCR. 

Step  18 Use the Line Data field to specify whether the line data is digital or 
analog.
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Automated Call Distribution (ACD) Tab

The ACD tab (Figure 7-20) is used to configure the ACD system to 
connect large amounts of incoming calls automatically to groups 
composed of ACD agent positions. These calls are processed in the order 
of their arrival, and are distributed evenly among the ACD agent 
positions in order to optimize personnel and save cost. 

Figure 7-20  Advanced Features - ACD Tab

IMPORTANT

Information entered in the fields on the Automated Call Distribution (ACD) tab are 
for Phase 1 installations only.

NOTE

The ACDP software must first be installed in order to use this feature. The 
Installation Manager is currently not assigning the ACD database (i.e., Splits, CCVs, 
etc.), only the System Data.
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You can disable the Automated Call Distribution by selecting the 
Disable ACD (Automated Call Distribution) check box.

• Edit button
When you select a OP Code Key, then click the Edit button,  
Figure 7-21 displays.

Figure 7-21  Edit ACD

— Modify the Chime field. The other fields cannot be changed from 
this ACD panel. 

The TMF (Terminal Multiple Information Transfer Facility) and MSF (Terminal Mode 
Set Facility) are facilities that Voice Server supports for communicating with the 
Dterm Single-Line phone.

NOTE
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Open Application Interface (OAI) Tab

The OAI Systemtab (Figure 7-22) is the interface joining a variety of 
facilities in the switch to the application programs in an external 
computer in accordance with the basic reference model of the Open 
Systems Interconnection (OSI) standardized by the ISO. The switch can 
be controlled by the external computer through the OAI system and 
offer users unique added values. 

Figure 7-22  Advanced Features - OAI Tab

IMPORTANT

Information entered in the fields on the Open Application Interface (OAI) tab are 
for Phase 1 installations only.

NOTE

The user is responsible for adding OAI keys to the user button templates.
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You can disable the Open Application Interface by selecting the Disable 
OAI (Open Application Interface) check box.

• New button
When the New button is selected, Figure 7-23 displays.

Figure 7-23  Edit OAI - New

— Enter or select the desired information in the Key Code, Chime, 
Facility Type, OP-Code, and Access Code fields.  

• Edit button
When the Edit button is selected, Figure 7-23 displays.

Figure 7-24  Edit OAI - Edit
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— Modify the Key Code, Chime, Facility Type, and OP-Code fields, 
as needed.

• Delete button
To delete an existing OAI, highlight the OAI to be removed and click 
the Delete button. Figure 7-25 will display to confirm whether you 
want to delete the OAI.

Figure 7-25  Confirm Delete
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Monitor Number Tab

AMNO assigns monitored numbers in the PBX. In a ACD system, the 
monitored numbers programmed in AMNO are the entry points for pilot 
numbers. Monitored Numbers are also used in OAI applications for call 
deflection. In the case of Attendant console, Monitored Number specifies 
the number the attendant dials to log on or log off the system. See 
Figure 7-26

Figure 7-26  Advanced Features - Monitor Number Tab

You can disable the Monitor Number by selecting the Disable Monitor 
Number check box.

• New button
When the New button is selected, Figure 7-27 displays.
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Figure 7-27  Monitor Number - New or Edit

— Enter, modify or select the desired information in the Monitor 
Number, UCD (Follow UCD), Use as Attendant Console, UCD 
Hunt Group, and Phase fields. 

• UCD Hunt Group field
To modify the UCD Hunt Group, select the Browse button.  
Figure 7-28 displays.
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Figure 7-28  Edit UCD Group Template

• Delete button
To delete an existing Monitor Number, highlight the Monitor number to 
be removed and click the Delete button. Figure 7-29 will display to 
confirm whether you want to delete the Monitor Number.

Figure 7-29  Confirm Delete
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8
User Assignments

This chapter describes the MA4000 Installation Manager’s User 
Assignments section.

The User Assignments (Figure 8-1) allows you to manipulate a large 
number of users from an easy to use graphical user interface. Import 
and Export, from and to CSV formatted files can be handled easily, no 
matter the size. In fact, the larger the import file the greater the time 
savings that can be achieved due to the efficiency and powerful 
capabilities afforded by the MA4000 Installation Manager. 

Figure 8-1  User Assignments Tab 
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• Edit button
You can select one or more records, then click the Edit button. 
Figure 8-2 and Figure 8-3 (Business system type) or Figure 8-4 and 
Figure 8-5 (Hospitality system type) displays. You can then edit all the 
records selected, one at a time.

Figure 8-2  Edit User - Business (except UMG)
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Figure 8-3  Edit User - Business (UMG only)
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Figure 8-4  Edit User - Hospitality (except UMG)
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Figure 8-5  Edit User - Hospitality (UMG only)

• Add User button 
 
The Add User button allows you to quickly add users while remaining 
in the Edit User dialog. When the Add User button is clicked, the 
user’s name fields will blank out. All other fields will remain. You can 
quickly add users with common information. 

• Delete User button 
 
The Delete User button deletes the current record. Figure 8-6 will be 
display.

Figure 8-6  Warning - Delete User Profile 
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User Assignments - New or Edit User

Last Name field
Last name of the user.

First Name field
First name of the user.

Phone Name Display field
Displays when you call another station. The length of this string, and its 
location, is dependent on the system settings. See “Station Ranges Tab” 
on page 6-2.

E-mail field
The contacts e-mail address. This information will be programmed in the 
UM4730 Voice Mail system mailbox, if applicable.

Phone Type field (Hospitality Only)
Select either the administration or guest room telephone type.

Room Class field (Hospitality Only)
Enter the room class (0 through 14). Each class label can be changed by 
selecting the specific class, clicking Browse, and entering the new label 
in the Edit Room Class dialog box Description field. 

Organization field
Describes the organization of the user. The organization is defined in 
“Organization section” on page 4-8.

LMG field (NEAX IPX UMG Only)
Use the LMG drop-down menu to specify the Local Module Group to 
which you are assigning the signaling server. (This step is only available 
on the NEAX IPX UMG.)

Annex field (Hospitality Only)
Enter the annex location. Each annex label can be changed by selecting 
the specific annex, clicking Browse, and entering the new label in the 
Edit Annex dialog box Description field.

Floor field (Hospitality Only)
Select the floor number and elevation. The floor number is selected by 
using the field’s scroll arrows. The elevation choices are Ground and 
Underground.
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Location field
Used to identify the location of your phone.

Phone Model field

The models listed will be based on the IP Phone Type option selected in Chapter 6, 
System Information, Station Ranges Tab.

• Phone Model Browse button 
 
Clicking the Browse button located next to Phone Model field allows 
you to access additional information addressing the phone model as 
shown in Figure 8-7. This dialog provides a detailed description the 
phone and a list of its features.

Figure 8-7  Phone Model - General Tab 

— Phone Model field 
 
You can select a model and view detailed information on that 
particular phone.

NOTE
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Button Template field
The Button Template field allows you to select a button template. This 
template contains definitions for the buttons for that particular phone 
model. 

• Phone Model Browse button 
 
You may edit the template by clicking the “...” button. In this case, 
editing will effect the template for all users assigned that template.  
 
The Button Layout editor is a single application that handles the 
button layout template editing for 2, 8, 16, 24, and 32 button phones 
in the E Series, I Series, Dterm IP (ITR), and INASET (ITR-LC) phone 
models. 
 
Figure 8-8, Figure 8-13, and Figure 8-14 display the Button Template 
editor.

Figure 8-8  Button Template Editor- Edit Button Template Tab 

Download from Www.Somanuals.com. All Manuals Search And Download.



User Assignments         8-9

MA4000 Installation Manager User Guide - Revision 7

— Macros 
 
All template editors make heavy use of macros. When the project 
is compiled, the MA4000 Installation Manager provides a value for 
each user wherever the macro is used. See Table 8-1.

Table 8-1  Macros

Macro Description TEC
{MYLINE = PRIMELINE} This is the primary physical phone number 

(assigned to the hardware LEN with a physical 
station number) of the user and is to be set as the 
Prime Line. 

TEC = 12

{MYLINE} This is the primary physical phone number 
(assigned to the hardware LEN) of the user but it is 
not set as the Prime Line.

TEC = 12

{PRIMELINE} This is the line which is selected by default when 
the station is off-hook This number is assigned from 
the OFFSET Station Range. 

TEC = 18

{SUBLINE} A Subline applied to a button of a phone would not 
be automatically placed in a Pilot Hunt Group with 
the MyLine/PrimeLine of the phone. Only one 
SUBLINE is allowed per key Data Template. This 
number is assigned from the OFFSET Station 
Range.

TEC = 18

{ADDITIONAL SUBLINE} This is used in configurations with more than one 
defined {SUBLINE}.

TEC = 18

{USER NAME} Provides pull-down menu to select user TEC = 3, 12, 18

{MANUAL ENTRY} Provides an edit box to enter a numeric value for a 
station

TEC = 3, 12, 18

{DSS ENTRY} Provides DSS information for a station TEC = 3, 12, 18

— Button Template Editor - Edit Button Template Tab
• Name field

The name of the button layout template is the value shown 
in the list of button layout templates on the Edit User dialog.

• Feature Type field
The Feature Type field provides a list of available features. 
Available options are displayed in Figure 8-9 through Figure 
8-11.

• Key Data Programming list
The list located below the Name field (see Figure 8-8) 
displays each key, a description of the programming for that 
key, and the label. This area does not provide direct editing 
capabilities. You can select a key and assign a value using 
the data entry boxes to the right of the list.

• Flex Keys field
This field allows you to either show or hide the Flex Keys.
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• Clear Keys button
Clicking the Clear Keys button eliminates all the key 
definitions currently existing in the Key Data Programming 
List.

Figure 8-9  Button Template Editor - Feature Type: Not Assigned 

Figure 8-10  Button Template Editor - Feature Type: Function 

• Button Label field
The suggested, editable label for the function selected.

• Feature By Name field
The Features By Name combo box is a filter for the list. 
The user is able to simply select from a list of Call 
Forwarding features rather than search through hundreds of 
other features.
A user can assign a feature to a key by selecting the key in 
the listing and then double click the feature in the Features 
list. The result is that the feature is assigned.
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The numeric value of the function as specified by the 
SV7000, R16 manual. You can display all the features 
available, or just by the ACD, AD64, Call Forwarding, CALL 
PICKUP/PAGE, or FLEX group.

Figure 8-11  Button Template Editor - Feature Type: Station 

• Button Label field
The suggested, editable label for the function selected.

• Station Value field
You can select from those items listed in Table 8-1.

• Ring Type field
You can select from a list of seven different ring types to the 
user: 
 
0: No Ring 
1: Day Ring, No Delay 
2: Night Ring, No Delay 
3: ...Not Used... 
4: D/N Ring, 30 Second Delay 
5: D/N Ring, 20 Second Delay 
6: D/N Ring, 10 Second Delay 
7: D/N Ring, No Delay 
 
Each selection has a number associated to it for quick data 
entry. For instance, a 7 results in a No Delay ring type.

• Route Restrictions (RSC) field
You can select either Use Myline Settings or RSC - 0 
through RSC - 15.
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• Service Restrictions (SFC) field
You can select either Use Myline Settings, SFC - 0 
Reserved for Trunks, SFC - 1 through SFC - 13, SFC -14 
Conferencing, or SFC - 15 ACD.

• Call Forwarding field
You can select either the Default Call Forwarding, None, 
Use Myline Settings, or New option.

• Name Display field
Select the None, Use Myline Settings or Custom option.

If the Custom option is selected in the Name Display field, the Custom Name 
Display Value field displays.

Figure 8-12  Button Template Editor - Feature Type: Station - Name Display: Custom

NOTE
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— Button Template Editor - Advanced Tab 
 
The Advanced tab (Figure 8-13) consists of system specific data or 
data that is typically defaulted for 90% or more of the user.

Figure 8-13  Advanced - Button Template - Advanced Tab 

Table 8-2  Advanced Button Template Options

Field Options

Priority of Answering Call

• Line Preference Pattern for Speaker Button (Default)
• Dial ICM, Line Preference Pattern for Speaker Button
• Automatic ICM, Line Preference Pattern for Speaker Button
• Manual ICM, Line Preference Pattern for Speaker Button
• Automatic ICM, Manual ICM, Line Preference Pattern for Speaker 

Button

Key Preferences
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Line Preference

• Prime Line Pickup (Default)
• Set For Other Buttons

Note: Speaker, Answer, and Originate Preference areas are only 
configurable if the Line Preference = "Set For Other Buttons"

Speaker Key

• Prime Line Pickup (Default)
• Idle-Line
• Incoming-Line
• Ringing-Line

Answer Key
• Prime Line Pickup (Default)
• Incoming-Line
• Ringing-Line

Originating Key
• Prime Line Pickup (Default)
• Idle-Line
• Prime/Idle-Line

Message Waiting Display
• Top Line (Default)
• Bottom Line

Off-Hook Suppression
• No (Default)
• Yes 

Note: Selecting Yes enables support for offhook suppression.

Soft Key

Pattern

• 0 (Default)
• 1 to 15

Note: The Soft Key Pattern offers the user a choice between pattern 
0 to 15. These patterns are stored in the switch. The patterns 
themselves will not be programmed by MA4000 Installation 
Manager.

Important: There may be some models that do not have Soft Keys. 
In those cases, the Soft-Key Pattern and Scroll Key 
controls will be ignored.

Scroll Key
• On 4th Key of Soft-Keys (Default)
• Allow on Line/Feature Keys

Field Options
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— Button Template Editor - Information Tab

Figure 8-14  Button Template Editor - Information Tab 
 

Button Layout Section

The graphic of the phone is provided to the user to show 
them the button layout. This helps the user match up a 
particular button with the key number in the list to the right.
The graphic is static and provides no interaction. The picture 
simply displays the location of each button by number.

• Notes field
The notes are displayed in the Manage Template listing.
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Station Range Type field
This section changes depending on the Type selection. 

• Manual Option
You can manually assign an extension number to this user. The user 
enters the station number in the Station Number field.

• Station Range 
 
Allows the automatic selection of the station number or creation of a 
new number.

— To create a new Station Range, select the <New... > option. When 
Figure 8-15 displays, enter the desired information.

Figure 8-15  New Station Range
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Route Restrictions (RSC) field
The Route Restriction numbers in the system. There are only 16 
available, numbered 0 through 15.

Service Restrictions (SFC) field
The Service Feature Class numbers in the system. There are only 15 
available, numbered 1 through 15. Figure 7-5 displays when the 
Browse button is selected.

Call Forward field
The Call Forward Template allows the user to select a template that 
will be used to apply the call forwarding behavior for this user.

Selecting the Browse button will display a dialog behaving slightly 
differently depending on the system setting for Call Forwarding. Figure 
8-16 and Figure 8-17 are the same for either type of Call Forwarding 
setting.

Figure 8-16  Edit Call Forwarding Template - General 
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Table 8-3  Edit Call Forwarding Template Options

Option Description
{NO ENTRY} Do not program this call forwarding option.

{VOICE MAIL} Assign the voice mail pilot number here.

{ATTENDANT} Assign the attendant console number as defined in the System 
Options tab.

{SUBLINE} Allow call forwarding to subline.

USER NAME
Provides a display area and user interface mechanism for assigning 
a user to this call forwarding feature. During compiling, the user 
name is replaced with their actual station number they are provided.

MANUAL ENTRY Provides an edit box for the user to enter a numeric value for a 
station.

Figure 8-17  Edit Call Forwarding Template - Information 
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Voice Mail Template

Figure 8-18  New Voice Mail Template - General 

Synchronize with VM Server button
Select this button to the match the current template properties with the 
VM server.

NOTE

This option is not available unless the Voice Mail is programmed and on-line.
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Reset Values to Default button
Select this button to reset the current template properties to the default 
values.

Figure 8-19  New Voice Mail Template - Information 
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Group Memberships section

Understanding the Group Assignments
The Group Assignments lets you define call handling for groups of users. 
Groups should contain at least two members. If you create a new group 
containing fewer than two members, Installation Manager displays a 
warning dialog and will write an error notice to the installation log during 
a compile. You can create five types of group assignments:

• Hunt Group - Circular: An incoming call proceeds through a group 
of up to 100 stations until it reaches a not-busy station. Calls to any 
member of this group will be processed the same way. The secretary 
station is optional. If it exists, the call will be directed to the secretary 
station if all the stations in a hunt group are busy.

• Hunt Group - Pilot: Incoming calls to the pilot number begin the 
hunting sequence. Calls to busy stations, other than the pilot number, 
receive a busy tone. The secretary station is optional. If it exists, the 
call will be directed to the secretary station if all the stations in a hunt 
group are busy.

• UCD Group: Incoming calls are distributed to a group of up to 100 
stations. Calls are distributed to idle stations in a circular pattern, in 
the order in which they arrive.

• Pickup Group: A group of stations with the ability to pick up calls 
made to any other member of the group.

• Secretary: A user can be defined as a secretary allowing that user to 
be used by the group assignment. A secretary can be assigned to 
multiple groups (multiple secretary feature), but not as a member of 
the Pilot or Circular Hunt groups. 

Figure 8-20  Edit User - Group Memberships 

Pickup field
In the event a member is already assigned to a hunt or pickup group, 
selecting a different template from the list will have the effect of 
removing them from the prior hunt/pickup group and adding them to 
the new one (only allowed in the case that the new hunt/pickup group is 
not already full). In the case where the new hunt/pickup group is full 
already, the user will be prompted to either edit the newly selected 
pickup group to make room for this member, or add a new pickup group 
template. See Figure 8-21, Figure 8-22, and Figure 8-23.
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Figure 8-21  New Pickup Group Template - General 

• Add button
The Add button creates a new entry. Figure 8-22 displays.

• Delete button
The Delete button removes a selected entry.

• Move Up button
The Move Up button moves an entry up until the entry is located 
where you want it to be.

• Move Down button
The Move Down button moves an entry down until the entry is 
located where you want it to be.
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Figure 8-22  Select Users 

Download from Www.Somanuals.com. All Manuals Search And Download.



8-24         User Assignments

MA4000 Installation Manager User Guide - Revision 7

Figure 8-23  New Pickup Group Template - Information 

— The Notes field allows the user to enter any free form text 
associated with a user. 
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Hunt Fields
When a hunt group template is chosen the user is automatically added 
to the hunt group. The template determines whether the hunt group is 
Circular, Pilot, or UCD.

In the event that the hunt group already has 100 members, the user will 
be notified and given the option to create a new group or edit the 
selected group to make room for this member.

In the event a member already is assigned to a hunt or pickup group, 
selecting a different template from the list will have the effect of 
removing them from the prior hunt group and adding them to the new 
one (only allowed in the case that the new hunt/pickup group is not 
already full). In the case where the new hunt/pickup group is full 
already, the user will be prompted to either edit the newly selected 
hunt/pickup group to make room for this member, or add a new hunt/
pickup group template.

The user can select the Browse button to launch the Hunt (Circular/
Pilot) and Hunt (UCD) field editors. 

Hunt (Circular/Pilot) 
Options:

• None
• New Circular Hunt Group (see Figure 8-24)
• New Pilot Hunt Group (see Figure 8-25)
• Secretary (see Figure 8-26)
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Figure 8-24  Edit Hunt Group - Circular Template Option 
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Figure 8-25  New Hunt Group - Pilot Template Option
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Figure 8-26  Secretary Option
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Hunt (UCD)
Options:

• None
• New (see Figure 8-27)

Figure 8-27  New UCD Group Template
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Misc Section

Figure 8-28  Misc. 

Jack ID field
The Jack ID is used only for reporting purposes. It is useful when it 
comes to cable management, phone placement and running of cross-
connects.

Old Phone Number field
The user’s previous phone number.

Phone Hardware Accessories field
The user can select from a list of Phone Hardware Options templates 
(see Figure 8-29 and Figure 8-30). If the user clicks the Browse button, 
the user will be shown in the Accessories Editor.

This information is used for reporting purposes only. No validation will 
be performed. See Table 8-4 and Table 8-5.
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Figure 8-29  Edit Phone Accessory Template - General 

Table 8-4  

Option Description
Template Name User enters a unique Phone Accessories Template name here.

Handset Cord This is the length of the cord from the handset to the base. The user 
has the choice from 7 foot, 12 foot, or 25 foot cords.

Base Cord The user has a choice of 7 foot, 14 foot, and 25 foot cords. This is 
the cable length from the phone to the wall.

Headset The user has the choice of Yes or No headset.

Wallmount The user has the choice of Yes or No for a wall mount adaptor.

Adapter

The Adapter section only applies to phone types that are Series i or 
Series E. If this template is used on a phone that is neither one of 
these model, then the reporting will be off. Since this information is 
provided as a convenience to the user, and there is no system 
programming associated with any of these options, then it is up to 
the user to make this information meaningful. It is suggested that, if 
needed, the user create separate templates for phone models that 
support adapters and those that do not.
The column Common Listing will be the available selections in the 
Adapter drop-down box. See Table 8-5.

Edit Phone Accessory Template Options
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Table 8-5  Phone Adapters

Series i Series E Common Listing Remarks
AD(A) ADA-U ADA Ancillary Device Adapter

AP(A) APA Analog Port Adapter w/o Ringer

AP(R) APR-U APR Analog Port Adapter w/Ringer

HFU-U HFU Hands Free Unit

CT(A) CTA-U CTA Computer Telephony Adapter

CT(U) CTU Computer Telephony Adapter (USB)

IP-R IPA-U IPA IP Adapter

LLA LLA Long Line Adapter

Figure 8-30  Edit Phone Accessory Template - Information 

• Delete button
The user must first select one or more items in the list shown in Figure 
8-1, “User Assignments Tab” on page 8-1. Once they are selected, the 
user clicks the Delete button. Figure 8-31 displays. Clicking the Yes 
button will permanently delete the data from the project. Selecting the 
No button will cancel the operation.
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Figure 8-31  Warning - Delete User Profile 
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Import button
The Import button launches the User Import Wizard. The User Import 
Wizard allows the user to import the user information from a text (or 
.csv) file. The data format for the import file can be either:

— Tab delimited
— Comma delimited 

Both layouts are the standard for Microsoft Excel output format.

Import User Wizard
• Welcome Panel 

Figure 8-32  User Update Wizard - Welcome to Installation Manager User Import 

Step  1 Select the Next button to proceed. Figure 8-33 displays.
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Figure 8-33  User Import Wizard - Import File 

Step  2 Use the Location of file field to specify the complete path and file name 
to be used to import users, or select the Browse button to open an 
existing file. 

Step  3 After the file is selected, click the Next button to continue. Figure 8-34 
displays.
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Figure 8-34  Record Separation - Record Delimiter 

Step  4 Provide the end of line delimiter to use. The delimiter character choices 
are:

—Comma
—Space
—Tab

Step  5 Click the Next button to continue. Figure 8-35 displays.
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Figure 8-35  Select Import Value - Field Names 

Step  6 You may change the name of any of the fields being imported by 
selecting the field name and editing its name in the Name field. When 
finished, click the Next button to continue. 

Step  7 Click the Next button when finished. Figure 8-36 displays.
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Figure 8-36  Default Values - Field Mapping 

Step  8 For each field option listed in the left column, use each drop-down box 
located in the right column to select the matching imported field. Figure 
8-37 displays.
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Figure 8-37  Column Match - Default Values 

Step  9 Specify the default values for each important field for each user. When 
finished, click the Next button. 

Step  10 The User Import Wizard will begin importing each file and creating new 
users. When finished, Figure 8-38 displays.
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Figure 8-38  User Import Wizard - Completing User Import Data

Step  11 After the file is imported, the user is presented with the results of the 
import. If there were any errors, they will be reported here as well. 

Step  12 Click the Finish button to close the wizard.
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• Export button
The Export button allows the user to export the list of selected users. 
The user will first select a set of users and click the Export button. 
When the user clicks the Export button, Figure 8-39 displays. 

Figure 8-39  Save As - Export Users 

The User Export function exports all the information on the Edit User 
dialog. The following information items listed are:

• Last Name
• First Name
• Phone Name Display
• Organization
• Location
• Phone Model
• Class Template Name
• Station Number
• Button Template Name
• Call Forwarding Template Name
• Accessories Template Name
• Voice Mail Template Name
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• Pickup Group Name
• Hunt Group Name
• Jack ID
• Old Phone Number
After the export is complete, Figure 8-40 displays.

Figure 8-40  Success - Export User

When importing from the results of an export operation, there will be some 
information that will need to be specified upon re-importing. Specifically the template 
information is exported but will not be re-used on import. The user will need to 
specify a default template for each template as the users are imported.NOTE
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• Update Wizard button

Figure 8-41  User Update Wizard - Welcome to Installation Manager User Update Wizard 

Step  13 Click the Next button to proceed. Figure 8-42 displays.
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Figure 8-42  User Update Wizard - Select Operation 

Step  14 Select the user records to update using the Add, Remove, Add All, or 
Remove All buttons, then click the Next button to proceed. Figure 8-43 
displays.
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Figure 8-43  User Update Wizard - Select Values 

Step  15 Set the default value of each field. Click the Next button to proceed. 
Figure 8-44 displays.

If a user selects a phone model with no button layout (Analog, SIP, etc.), the Button 
Template combo box will change to <Clear>.

NOTE
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Figure 8-44  User Update Wizard - Verify Settings 

Step  16 Review the settings specified. If satisfied with the values, click the Next 
button to continue.  Figure 8-45 displays.
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Figure 8-45  User Update Wizard - Completing the User Update Wizard 

Step  17 Click the Finish button.
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9
Group Assignments

This chapter describes the MA4000 Installation Manager’s Group 
Assignments section (Figure 9-1).

Figure 9-1  Group Assignments 

• Edit button
The user will select a group from the list box, then select the Edit 
button. This will allow the user to edit that hunt group. The dialog that 
is displayed (see Figure 9-2 and Figure 9-3) will depend on the hunt 
group selected. 
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• Edit Pickup Group 

Figure 9-2  Edit Pickup Groups Template - General 
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Figure 9-3  Edit Pickup Groups Template - Information 
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• New button
When the user selects the New button, Figure 9-4 displays. 

Figure 9-4  Select Users - New Group

Step  1 Use the radio buttons to select the appropriate Group Type, then click 
the OK button. 

—When the Hunt Group - Circular type is selected, Figure 9-5 and 
Figure 9-6 tab screens display.

—When the Hunt Group - Pilot type is selected, Figure 9-7 and Figure 
9-8 tab screens display.

—When the UCD Group type is selected, Figure 9-9 and Figure 9-10 tab 
screens display.

—When the Pickup Group type is selected, Figure 9-11 and Figure 9-12 
tab screens display.

The minimum number of entries for a Group is 2.

NOTE
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Figure 9-5  New Hunt Group - Circular Template - Group 
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Figure 9-6  New Hunt Group - Circular Template - Information 
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Figure 9-7  New Hunt Group - Pilot Template - Group 

The same secretary may be included in multiple groups (the multiple secretary 
feature). The secretary can not be a member of Pilot or Circular Hunt Groups.

NOTE
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Figure 9-8  New Hunt Group - Pilot Template - Information
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Figure 9-9  New UCD Group Template - Group
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Figure 9-10  New UCD Group Template - Information 
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Figure 9-11  New Pickup Groups Template - General 
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Figure 9-12  New Pickup Group Template - Information 

• Delete button
The user first selects a hunt group to delete, then clicks the Delete 
button. Figure 9-13 displays.

Figure 9-13  Confirm Delete - Delete This User Group Assignment 
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10
Circuit Card Assignments

This chapter describes the MA4000 Installation Manager’s Circuit Card 
Assignments section (Figure 10-1).

Figure 10-1  Circuit Card Assignments Tab

NOTE

Right-clicking an existing or blank circuit card assignment slot causes a dialog box to 
display providing you the ability to edit or delete an existing assigned chassis, or 
assign a new Virtual chassis.
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Figure 10-2  NEAX IPX / IPX DM / UNIVERGE IPX Circuit Card Assignments 
 

Figure 10-3  UNIVERGE SV7000 Circuit Card Assignments
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Figure 10-4  NEAX IPX UMG Circuit Card Assignments

Creating a New Circuit Card Assignment (UMG)
An Ultra Module Group (UMG) system contains up to four Local Module 
Groups (LMGs), each of which can contain up to four Interface Module 
Groups (IMGs) and 16 Peripheral Interface Modules (PIMs). 

To create a new circuit card assignment, do the following:

Step  1 Launch Installation Manager. The Startup dialog displays.

Step  2 Click the Projects tab, if necessary.

Step  3 Click a project in the list, then click OK. The Installation Manager main 
window displays.

Step  4 Click the Circuit Card Assignments tab. A graphic outline 
representation of your system displays.

Step  5 Click a location to select where you wish to add a PIM.

Step  6 Click New. The New Chassis dialog displays (see Figure 10-8).

Step  7 Click a radio button to specify whether you are defining a physical (9U or 
6U) or virtual chassis (PIM), then click OK. A blank chassis (PIM) 
displays in the system outline.

Step  8 Double-click the on-screen, or click Zoom In. A detailed view of the 
chassis’s slots displays.
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Step  9 Click in the diagram or use the Slot drop-down menu to select a slot you 
wish to configure (see Figure 10-7).

Step  10 Use the Card drop-down menu to select the card you wish to configure in 
the selected slot. If the card must be configured with additional 
parameters, the Edit Circuit Card dialog displays (see “Setup IP... button” 
on page 5-5).

You can also right-click a particular a slot in the diagram to display a pop-up menu, 
select the Insert Card option, then select the desired card from the displayed list.

Step  11 Complete the Edit Circuit Card dialog with the appropriate values for the 
card you are adding.

If you are configuring a physical protocol handler card refer to the following field 
descriptions. Some options may not be available, based on the type of MG card you 
wish to configure:

• Name - Device name
• Route Count - Number of the route that will be created for this device
• Data Ch. Route Name - The B-channel name

If you are configuring a trunk card refer to the following descriptions:

• Name - Device name
• Default Gateway Address - IP address of your network’s gateway router
• DRS Address - IP address of the Device Registration Server
• IP Address - Device IP address. Each media gateway must have a separate IP address
• Network Mask - Device IP network mask

Step  12 Click Zoom Out to return to the large-scale system view.

Step  13 (Optional) Repeat Steps 5-12 for any additional circuit cards you wish to 
assign.

NOTE

NOTE

NOTE
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Figure 10-5  UNVERGE SV8500 Circuit Card Assignments

The Chassis LEN numbers (see Figure 10-6) are based on the 
information provided by the user when the “Create Project Wizard” on 
page 3-7 is performed. Specifically, the number of ports selected in the 
System Maximum Capacity field (see Figure 3-10, “Create Project 
Wizard - Project Name and Type - NEAX IPX and NEAX IPX DM” on page 
3-7). 

Figure 10-6  Chassis LEN Number 
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• Zoom In button
When the Zoom In button is clicked, Figure 10-7 displays.

Figure 10-7  Circuit Card Assignments - Edit Chassis 

Right-clicking any circuit card slot allows you to delete or edit an existing assigned 
circuit card, or insert a new circuit card by selecting it from the Insert Card pop-up 
menu.

You can not insert, edit, or delete a circuit card in slot #23. 

• Zoom Out button
Clicking the Zoom Out button returns you to Figure 10-2,  
Figure 10-3, or Figure 10-4. 

• New button
When the New button is clicked, Figure 10-8 displays.

NOTE

NOTE
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Figure 10-8  New Chassis 

— Select the Physical Chassis or Virtual Chassis option button to 
add the desired PIR to the Circuit Card Assignments panel.

 

• Delete button
To delete an existing Virtual Chassis from the Circuit Card 
assignments, click the Delete button. Figure 10-9 displays. 

Figure 10-9  Warning - Delete Virtual Chassis 
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11
Install

This chapter describes the MA4000 Installation Manager’s Install 
section (Figure 11-1).

Figure 11-1  Pre-Installation Check List 

Step  1 Ensure all the actions listed in the checklist are completed before 
continuing with installation.

Step  2 Click the Next button to proceed. Figure 11-2 displays.

Figure 11-2  Choose the Features You Want to Install 
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Step  3 Select the features to use during installation.

—Compile Installation Plan
—Flash System Memory Card (SV8500 not supported)
—Register System
—Backup System Data Before Uploading Data
—Upload Data To System
—Upload Voice Mail Data

Step  4 Click the Next button to continue. Figure 11-3 displays for the 
UNIVERGE SV7000. In the Select Installation Phase drop-down field, 
choose the phased installation desired. Use the checklist on the dialog 
box to ensure all restrictions are followed when using a phased 
installations.

Click the Phased Installation Guide hyperlink for additional information on this 
procedure. A Microsoft Word document will display.

The Phased Installation Check List dialog box (Figure 11-3) will not display if the 
phased installation was not selected.

NOTE

REFERENCE
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Figure 11-3  Phased Installation Check List

Step  5 Click the Next button to proceed. Figure 11-4 displays providing the 
progress status throughout the compiling process. It provides the status 
of what is currently being compiled, a list of warnings, and a list of errors.
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Figure 11-4  Compile User Phone Assignments Progress
 

—If an error is encountered during the compiling process, Figure 11-5 
displays.
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Figure 11-5  Installation Warning - Stop Installation Query

—Select the Yes button to halt the installation immediately.
—Select the No button to ignore the error encountered and continue.
—Select the No to All button to ignore this error and others 

encountered.

Step  6 When the compiling process finishes, Figure 11-6 displays.
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Figure 11-6  Initialization of System Flash Card

UNIVERGE SV8500 is not supported.

 

The flash card installation needs to be installed using the MPS System CD-ROM.

Step  7 To initialize a System Flash Card:

—Insert the Flash Card into the PC PCMCIA slot.
—Insert the SV7000 software CD into the CD-ROM drive.
—Click the Initialize Flash Card ... button.

NOTE

IMPORTANT
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—When complete exit the program. Figure 3-31 and Figure 11-7 or 
Figure 11-8 displays.

When Figure 3-31 displays, perform the steps necessary to proceed with SV7000 
installation.

Figure 11-7  Installing SV7000 Flash Card 

NOTE
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Figure 11-8  Installing IPX Flash Card

Step  8 Follow the installation procedures listed.

Step  9 When the system is powered up, click the Next button. Figure 11-13 
displays.
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Figure 11-9  System Software Registration
 

Step  10 Activate the registration process by clicking the Register System button.

See “If the Initial Installation Execute button is clicked, Figure 3-32 displays.” on 
page 3-26 for the steps required to collect the customer information, contact NEC’s 
Registration Server, and obtain license key required to activate the SV7000.

Step  11 When the Registration Wizard process finishes, Figure 11-10 displays.

NOTE
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Figure 11-10  Backup/Restore Voice Server Data Memory 

Step  12 Select the type of backup to perform then select the Next button. Figure 
11-12 displays.
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Figure 11-11  Media Gateway Setup

Step  13 Ensure each Media Gateway has been configured and connected to the 
network, then select the Next button. Figure 11-12 displays.

The Media Gateway Setup dialog box will not display if there is no Media Gateway 
circuit card inserted.

NOTE
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Figure 11-12  Upload Data to System

Step  14 After the installation plan upload finishes, Figure 11-13 displays.
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Figure 11-13  Voice Mail Server Setup

Step  15 Click the Next button. Figure 11-14 displays.
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Figure 11-14  Installation Complete 

Step  16 Click the Finish button to complete the installation process.
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12
Reports

This chapter describes the MA4000 Installation Manager’s Reports 
section (Figure 12-1). 

The user will be able to print several useful reports. Many reports won’t 
be meaningful or useful until the information has been compiled. If 
there is not sufficient information when a report is launched the user will 
see a blank report.

Figure 12-1  Reports - General Tab
 

Table 12-1 lists all the reports available and provides a brief description 
of each.
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Creating and Printing a Report or DESI Label
Step  1 Click a report to select it, then click Run. The report dialog displays.

Step  2 Click a radio button, drop-down list, or check box to specify the report's 
scope, then click OK. 

The options available varies with each report.

 

Installation Manager creates the report and displays it in a new window.

Table 12-1  Description of Reports

NOTE

General Tab Reports

Extension Report
Displays User Data - Users, Extensions, Phone Models, 
Restrictions, Groups, Call Forwarding, Button, and Voice Mail 
templates.

Location Diversity Report Displays Pool Number Used List, Station and Station/Key Template 
Report.

Station Range Report Displays Station Range and Reserved Stations.

Task Report Prints a report of all tasks for a project.

User Acceptance
Sign Off Report

Prints information to be used by CSR to obtain the customers 
acceptance of the user and phone configuration. User selects which 
reports to include: Extension Detail, Extension Summary, Groups, 
Voice Mail Report.

Voice Mail Report Detail and Summary reports. Prints Mailboxes defined, extensions 
associated to, templates assigned.

Technical Tab Reports
Call Forwarding Report Displays Call Forwarding Data - Users, Extensions, and Templates.

Access Codes and Speed
Calling Codes Report Displays Access Codes and Speed Calling Codes.

Group Report Displays Group Data - Circular Hunt, Pilot Hunt, UCD Hunt, and 
Rollover.

Hardware Report Displays Hardware Data - Circuit Cards, Phone Models, and Phone 
Adapters.

Least Cost Routing and System 
Feature Report

Displays Least Cost Routing and System Feature Data - Local and 
Network LCR Patterns, Time of Day, and System Feature (ASYD).

Phone Placement Report Displays Phone Placement Data - Users, Extensions, Phone 
Models, Cord Lengths, Organizations, and Locations.

Restriction and Feature Report Displays Restriction and Feature Data - Route Restriction (RSC), 
Toll Restriction, and Service Feature Restriction (SFC).

Technician Cut Sheet Displays Hardware Installation Information - Extensions, IMGs, 
PIMs, SLOTs, and LENs.

DESI Label Reports
DESI Label for Series i

(DTR-16D)/DtermIP (ITR-16D)
Prints Desi labels for a single user, for a range of users, or for all 
users. 
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DESI Label for Series E
(DTP-16D)

Prints Desi labels for a single user, for a range of users, or for all 
users.

DESI Label for Series i 
(DTR-2D)

Prints Desi labels for a single user, for a range of users, or for all 
users. 

DESI Label for Series E 
(DTP-2D)

Prints Desi labels for a single user, for a range of users, or for all 
users. 

DESI Label for Series i
(DTR-32D)/DtermIP (ITR-32D)

Prints Desi labels for a single user, for a range of users, or for all 
users. 

DESI Label for Series E
(DTP-32D)

Prints Desi labels for a single user, for a range of users, or for all 
users. 

DESI Label for Series i
(DTR-8D)/DtermIP (ITR-8D)

Prints Desi labels for a single user, for a range of users, or for all 
users. 

DESI Label for Series E 
(DTP-8D)

Prints Desi labels for a single user, for a range of users, or for all 
users. 

DESI Label for DtermIP
(ITR-4D)

Prints Desi labels for a single user, for a range of users, or for all 
users. 
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13
Productivity Features

This chapter describes the MA4000 Installation Manager’s Productivity 
Features section (Figure 13-1) tabs. 

Chapter Topic • Configuration Tab
• Management Tab
• Diagnostic Tab
• Maintenance Tab

Figure 13-1  Productivity Features Tab
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The Productivity Features menu provides access to applications you 
use in conjunction with Installation Manager. These applications launch 
in a separate window and perform specific functions you need to 
configure your system properly. Some of these applications are also 
available from the Tools menu.

The Tools tab contains four sub-tabs:

• Configuration
• Management
• Diagnostic
• Maintenance

Some options within a tab may not display, or may not be available, 
based on your system type and certain options you selected during your 
system's installation.

Configuration Tab

The Configuration tab (Figure 13-2) consists of the following 
applications:

• UC Suite - MA4000 Manager Allows the user to load existing 
Installation Manager data to the 
MA4000. 

• Clipboard Provides the user with integrated 
access to the MAT Clipboard 
application (see Clipboard... for 
additional information on this 
option).

• Location Diversity Provides fault tolerance for IP 
telephones in an FCCS (Fusion) 
network by providing stations the 
ability to register with up to two 
back-up IP-PBX nodes in the 
network providing fail-over services 
to the physical/virtual station in the 
event of a communications failure 
between the station and its primary 
IP-PBX. 
 
Note: While the IP terminals are 
under the control of a backup node, 
the station can continue to function 
until the primary node becomes 
available. Not all station 
functionality is available while it is 
operating on one of the backup 
nodes (for example, appearance, 
dependencies, etc.)
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Figure 13-2  Productivity Features - Configuration Tab
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UC Suite - MA4000 Manager
Step  1 Select Tools → Configuration → UC Suite — MA4000 Manager, then 

click the Run button. Figure 13-3 displays.

Figure 13-3  UC Suite - MA4000 Manager
\

Step  2 Enter the MA4000 connection and transfer settings described in  
Table 13-1.

The server information entered in this section are added to the database and used 
when data is transferred to the MA4000.

—Click Start to load the Installation Manager data to a MA4000.
—Click Stop to end the data uploading process to the MA4000 before 

the transfer finishes.
—Click View Status to display a dialog showing detailed progress 

information about the current transfer. See Figure 13-4.
—Click Return to return to the Tool’s Configuration tab.
—Click Test Connection to ensure the MA4000 connection settings (for 

example, Root URL, etc.) are correct and MA4000 is running properly.

NOTE

Download from Www.Somanuals.com. All Manuals Search And Download.



Productivity Features         13-5

MA4000 Installation Manager User Guide - Revision 7

—Click Return to close the MA4000 Configuration dialog. This selection 
does not stop a current upload in progress.

Table 13-1  MA4000 Configuration Connection and Transfer Settings

Field Description
MA4000 Connection Settings

Root URL Enter the URL address for the MA4000 (for 
example, http://<host name>/MA4000).

User Name Enter the MA4000 user name to connect to the 
MA4000 web services.

Password Enter the MA4000 password to connect to the 
MA4000 web services.

MA4000 Transfer Settings

Fusion Network Name
IM                      MA4000

Edit  →  OK  

New  →  Create  

Edit  →  OK  

New  →  Error  

Stand-alone  

LCN

NCN

Enter the Fusion Network Name of which the PBX 
is a part.

• If the Fusion Network Name does not match the 
MA4000 database, and the Fusion Point code is 
a NCN, then create a new Fusion Network and 
add the PBX.

• If the Fusion Point code is a LCN, an error will 
return indicating the Fusion Network does not 
contain a NCN / No Fusion Network Found.

• If the Fusion Network Name does match the 
MA4000 database, and the Fusion Point Code is 
a NCN, then if the PBX details match the NCN 
node in the MA4000 Fusion Network, a PBX Def 
ID of the existing PBX is returned. Otherwise, an 
error displays indicting the Fusion Network 
already contains a NCN.  
 
If the Fusion Point code is a LCN, then the PBX 
needs to be added to the matching Fusion 
Network as a LCN node.

• If the Fusion Network is standalone, then create 
a PBX. 

PBX Settings Select to ensure the transfer of the PBX settings 
to the MA4000.

User Information Select to ensure the transfer of the user 
information. See User Assignments.

Note: The transfer of the PBX Settings option is 
automatically selected if this option is 
selected.

Organizational Level Select to ensure the transfer of the Organizational 
level information. See User Assignments.
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Figure 13-4  View Status Example
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Location Diversity 
Location Diversity allows you to register an IP telephone with up to two 
backup nodes when operating in a Fusion (FCCS) network. If the 
telephone is unable to communicate with its primary IP-PBX, the 
telephone automatically connects to one of the designated backup 
nodes. The telephone can continue operating under the backup node 
until the primary node becomes available. While connected to a backup 
node, some node-specific features, such as appearances and 
dependencies, are not available.

Step  1 Select Tools → Configuration → Location Diversity, then click the 
Run button. The Figure 13-5 warning dialog displays.

Figure 13-5  Warning - CPU Occupancy Level

Step  2 Read the warning information then click Continue.

The IP Address is defined in Connect Type section. See Hardware Information.

NOTE
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Location Diversity - FCCS Tab
Before you can begin configuring Location Diversity you must scan your 
Fusion network so Installation Manager can save node information to its 
database. Installation Manager saves the following node information:

• Extension
• TEC
• LEN
• Station Pool
• Station Backup
• Key Template

Figure 13-6  Location Diversity - FCCS Tab

Step  2 In the FCCS tab, enter the IP address of your Fusion network's entry 
point in the Fusion Entry Node field, then click Get Network Data. 
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—Installation Manager scans your network and displays a list of its 
nodes. For each node, the list displays the date and time it was last 
synchronized (if any).

The Get Network Data option allows Installation Manager to retrieve the current 
NDM data (for example, a list of backup stations, pool data, key template data, etc.). 

Step  3 Select the node you wish to synchronize and click the Synch button. 
Figure 13-7 displays. 

Figure 13-7  Location Diversity - FCCS Tab - Getting Location Data

—After successful synchronization, the Extensions, TEC, LENS, Station 
Pools, Station Backup and Key Templates are saved in the database. 
See Figure 13-8.

NOTE

NOTE

Access to the Location Diversity feature tabs are blocked during the synchronization 
process.
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Location Diversity - Station Backup Tab
Selecting the Station Backup tab (Figure 13-8) results in a table listing 
the existing backup nodes for visiting stations. 

Figure 13-8  Location Diversity - Station Backup Tab
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Designating Primary, Secondary, and Tertiary Backup Stations

Users can select multiple Primary stations and assign them to the list.

Step  1 To designate Primary, Secondary, and Tertiary stations, click New.  
Figure 13-9 displays a list of existing backup stations.

Figure 13-9  Location Diversity - Designating Backup Stations

The TELNs listed in the Primary TELN section shown in Figure 13-9 only display 
when a PBX Fusion Point Code is selected from the FPC drop-down menu.

Step  2 Use the FPC drop-down menu to select the Fusion Point Code of the 
PBX containing the station you wish to configure for Location Diversity.

Step  3 Select the primary stations (multiple stations can be selected) from the 
TELN/TEC list, then click >> to add it to the Backup Station section. 

—Installation Manager’s location diversity automatically finds the 
available pool numbers. If pools are not available, Location Diversity 
creates new pools.

NOTE

NOTE
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Step  4 Click the backup stations (multiple stations can be selected) in the list to 
select it, then use the IP-KIND drop-down menu to specify whether the 
backup station is a Dterm IP, SIP phone, etc.

Step  5 Click the Secondary drop-down menu to specify the PBX to which the 
selected station will attempt to connect if communication with the primary 
PBX fails.

Step  6 (Optional) Click the Tertiary drop-down menu to specify the PBX to 
which the selected station will attempt to connect if communication with 
both the primary and secondary PBXs fails.

Step  7 (Optional) Click New TELN to create a new extension number for the 
backup station.

Use only if there is no TELN number listed in the Primary TELN section.

Step  8 Click OK to accept the assignments.

—The new backup station displays in the list with a green background, 
indicating the data has not yet been uploaded to the PBX.

Editing Existing Backup Stations
The editing process allows the Installation Manager user to modify the 
following:

• Pool Number
• Tenant
• SFC
• RSC
• Name Display
• Key Template
• MAC Address 

Step  1 Use the FPC drop-down menu to select the Fusion Point Code of the 
PBX containing the station you wish to edit. 

Step  2 Click a station in the TELN/TEC list, then click Edit. Figure 13-10 
displays

NOTE
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Figure 13-10  Location Diversity - Extended Backup Data
 

Step  3 (Optional) Use the Remove Secondary Data check box to delete 
existing data for the secondary backup station.

Step  4 Use the drop-down menus in the Secondary pane to edit any of the 
following items for the selected backup station when connected to the 
Secondary backup PBX:

—FPC
—PNUM
—IP-KIND
—TN
—SFC
—RSC
—STN
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Step  5 (Optional) Use the Remove Tertiary Data check box to delete existing 
data for the tertiary backup station.

Step  6 (Optional) Use the drop-down menus in the Tertiary pane to edit any of 
the available items for the selected backup station when connected to 
the Tertiary backup PBX.

Step  7 In the Name Display pane, do one of the following:

—Enter a name which will display when the backup station is connected 
to the secondary or tertiary PBX.

—Select the No Name Display option button to specify that no name will 
display when the backup station is connected to the secondary or 
tertiary PBX. 

—Select the Use Primary's Name Display option button to specify that 
the selected backup station will display its primary name when 
connected to the secondary or tertiary PBX.

Step  8 Use the Key Template drop-down menu to specify which key template 
the backup station will use when connected to the secondary or tertiary 
PBX you can specify that the station will use no template, or a key 
template that was previously defined in the Key Template tab, or a 
customized template with no name.

If you choose to create a template with no name then that template applies only to 
the backup station you are editing and will not be available to other backup stations 
or listed in the Key Template tab. In essence, you are creating a "one-time-only" 
template.

Step  9 Use the MAC Address field to change the backup station's Machine 
Access Code address.

Step  10 (Optional - for TEC type 26 only) In the VPS Settings pane, use the text 
fields to enter the voice mail port number (VPSNO) and channel 
(VPSCH).

Step  11 Click Modify to save the edited data. Installation Manager saves the 
edited station data and displays the station name in the status list with a 
blue background, signifying the data has been modified but not yet 
uploaded.

Deleting Existing Backup Stations

Step  1 Use the FPC drop-down menu to select the Fusion Point Code of the 
PBX containing the station you wish to delete.

Step  2 Click a station in the TELN/TEC list to select it, then click Delete. 

—A confirmation dialog displays, asking if you wish to delete all the 
station data. 

NOTE
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Step  3 Click Yes to delete all the station data, or No to delete only the backup 
station from the list. 

—The entry now displays in the backup station list with a red 
background, indicating the station will be deleted during the next 
Location Diversity data upload.

Step  4 Use the backup station list to select a station scheduled for deletion 
(displaying a red background), right-click the name to display a context 
menu, then select UnDelete. 

—The station now will not be deleted during the next Location Diversity 
data upload. 
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Location Diversity - Station Pool Data Tab
Installation Manager Location Diversity allows users to reserve 
extensions by creating station pool data. See Figure 13-11.

Installation Manager displays a list of station pool information showing 
the last previously synchronized pool data. You can add new pool data 
(if there is none existing and you configure a backup station, Installation 
Manager creates it automatically), edit existing data, or delete an 
existing entry. Station pool data includes:

• Pool Number
• FPC
• TEC Type
• Starting Station
• Starting LEN
• Size
• Ending LEN

Figure 13-11  Location Diversity - Station Pool Data Tab
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The user can also add new pool data or edit/delete an existing pool. 
Installation Manager displays the last previously synchronized pool data 
in the table.

The Status column identifies the transaction. The fields are:

• <Blank>

Indicates existing pool data that has not been modified/deleted.

• New
• Modify
• Delete

Creating New Station Pool Data

Step  1 To create a new station pool data, click New. Figure 13-12 displays.

Figure 13-12  Location Diversity - Pool Data

 

—The Pool Number field is automatically assigned with the first 
available pool number.

Step  2 Using the FPC field, select the FPC where the pool will be created.

NOTE
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Step  3 Use the TEC Type field to select the appropriate pool number.

—Installation Manager’s location diversity populates the available LENS 
based on the TEC Type and Pool Size.

Step  4 Enter the beginning station of this pool in the Starting Station field. 

Step  5 Select the size of the pool using the Size field. The size are in blocks of 
eight.

Step  6 Use the Starting LENS field to specify the first Line Equipment Number 
to assign to the pool. 

—The Ending LENS field is automatically calculated when the Starting 
LENS is determined.

Step  7 Click Modify. The information is saved to the database and the pool data 
status is displayed as New.

Editing Station Pool Data

Step  1 Use the list to locate the data you wish to edit, then click to select it.

Step  2 Click Edit. The Pool Data dialog displays.

Step  3 Use the drop-down menus and text fields to edit any of the following, as 
necessary:

—FPC
—TEC Type
—Starting Station
—Starting LEN
—Size

Step  4 Click Modify. Installation Manager saves the edited station pool data and 
displays it in the status list with a blue background, signifying the pool 
data has been modified but not yet uploaded.

Deleting Station Pool Data

Step  1 Highlight the desired station pool data to be deleted from the table list, 
then click Delete. The entry now displays in the station pool data list with 
a red background, indicating the data will be deleted during the next 
Location Diversity data upload.

Step  2 Use the station pool data list to select a pool number scheduled for 
deletion (displaying a red background), then right-click the name to 
display a context menu. Select UnDelete. The pool data now will not be 
deleted during the next Location Diversity data upload.

If the station pool is already being used in the Station Backup, an error message 
displays notifying the user of the condition. The user must delete all the Station 
Backups that are assigned to the pool before removing it.

—After successful verification, the row status is marked as Delete.
NOTE
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Location Diversity - Key Template Tab
Installation Manager Location Diversity allows users to create new Key 
Templates and save the new template data to the database. See  
Figure 13-13.

Figure 13-13  Location Diversity - Key Template Tab
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Creating or Editing a Key Template

Step  1 To create a new Key Template, click New. Figure 13-14 and Figure 13-15 
display.

Figure 13-14  Location Diversity - Key Template - Base Information Tab

—Enter the template's name in the Name field or edit it, if necessary.
—Use the Priority of Answering Call drop-down menu to specify 

whether incoming calls should be answered based on Line Selection, 
Dial/Automatic/Manual Intercom lines, or a combination.

—Use the For Speaker button (SPK) drop-down menu to specify that 
the SPK button selects the prime line. (Currently the only available 
option.)

—Use the For Answering button (ANS) drop-down menu to specify 
whether the ANS button accepts the Prime Line, Incoming Line, or 
Ringing Line preference.

—Use the For Originating button (ORG) drop-down menu to specify 
whether the ORG button accepts the Prime Line or Idle Line 
preference, or a combination of the two.

—Use the Message Waiting Display drop-down menu to specify 
whether a message waiting indicator displays on the top or bottom line 
of a station's LCD display.
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—Use the Line Key Pattern drop-down menu to specify the number and 
type of key patterns assigned to the station.

—Use the Pattern drop-down menu to specify one of 16 key patterns the 
station will use.

—Use the Don’t Display Page Scroll Key [>>>] [PG] check box to 
choose whether to display a Page Scroll Key [>>>] [PG] on the display.

Figure 13-15  Location Diversity - Key Template - Function Key

—Use the Feature Type drop-down menu to specify whether you wish to 
add a Function or Station to the selected function key.

—If you selected Station, use the Station Value drop-down menu to 
specify whether the station is a MYLINE, PRIMELINE, 
MYLINE=PRIMELINE, or SUBLINE. Options available for each are: 
 
MYLINE Ringing Information 
 
PRIMELINE TELN number, Restrict OG (Off Hook 
 Suppression), and Ringing Information 
 
MYLINE=PRIMELINE Restrict OG (Off Hook Suppression),  

and Ringing Information 
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SUBLINE TELN number and Ringing Information 
 
If you selected Function, use the Features By Name list to select the 
feature you wish to assign to the selected function key. You can use 
the drop-down menu to limit the list to specific feature categories.

—Use the Flex Keys drop-down menu to enable or disable Flex Keys.
—Click the Clear Keys to remove all function key assignments.

Selecting Prime Line enables the Off Hook Suppression control for the user to 
select.

For field information, see “User Assignments - New or Edit User” on page 8-6.

Step  2 Click OK to save the key template data.

Deleting an Existing Key Template

Step Highlight the template to be deleted, then click Delete.

—Installation Manager schedules the key template for deletion during 
the next Location Diversity data upload and displays the template 
name with a red background.

Step  1 Use the key template data list to select a template scheduled for deletion 
(displaying a red background), right-click the name to display a context 
menu, then select UnDelete. 

—The template now will not be deleted during the next Location 
Diversity data upload.

REFERENCE

NOTE
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Location Diversity - ADVF Tab
Assignment of Default Value for FCCS Location Diversity

Installation Manager Location Diversity allows users to assign a default 
value for the FCCS Location Diversity. This is the default value of the 
basic information (UGN, TN, SFC and RSC) if these values are not 
specified in the Location Diversity commands. 

Step  1 Click the ADVF tab. Figure 13-16 displays.

Figure 13-16  Location Diversity - ADVF Tab

Step  2 Use the check boxes to select/deselect the following options, and enter 
their values in the related text field:

—Use as default value of User Group Number: UGN
—Use as default value of Tenant Number: TN
—Use as default value of Service Feature Class: SFC
—Use as default value of Route Service Class: RSC

Step  3 Click Save to save the ADVF data or Reset to restore the settings to 
their last previously saved values.
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Location Diversity - AFCMN Tab 
Assignment of FCCS Location Diversity Miscellaneous Data for NDM

Installation Manager Location Diversity allows users to assign FCCS 
Location Diversity Miscellaneous data for NDM. There are three types of 
default data set in this command. 

Step  1 Click the AFCMN tab. Figure 13-17 displays.

Figure 13-17  Location Diversity - AFCMN Tab 

Step  2 In the Node Data Settings pane, use the appropriate text field to enter 
values for the following items:

—Master Node IP Address
—Sub Master Node IP Address
—Port Number (default port is 60210)

Step  3 In the MAC Address Setting Password pane, enter your password in 
the appropriate field, then enter it again to confirm it.
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Step  4 In the Monitoring Level pane, enter a value between 60-300 seconds to 
specify how long a backup station waits before attempting to re-establish 
a connection to its original PBX.

Step  5 (Optional) In the Monitoring Level pane, use the check box to specify 
whether you wish to specify a station data synchronization processing 
time, then enter a value in the related text field.

Step  6 Use the check boxes to control how you wish a backup station to behave 
when attempting to reconnect to its original PBX. The options are:

—Immediate Switchover
—Specified-time Switchover 
—Manual Switchover

Step  7 Click Save to save the AFCMN data or Reset to restore the settings to 
their last previously saved values.
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Location Diversity - Upload Tab 
Installation Manager Location Diversity allows users to compile and 
upload specific data or all of the Location Diversity data to the FCCS 
network. 

Step  1 Click the Upload tab. See Figure 13-18.

Figure 13-18  Location Diversity - Upload Tab

Step  2 Use the Select Upload Data check boxes to specify the type of Location 
Diversity data you wish to upload, including:

—Station Backup Data
—Pool Data
—Template Data
—ADVF/AFCMN Data

Step  3 Click Compile, the compiling process begins, identifying potential 
problems or conflicts with the data before the Upload process. See 
Figure 13-19.
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Figure 13-19  Location Diversity - Upload Compile

Step  4 Clicking the Upload button sends all new and modified data to the fusion 
network.
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Management Tab

The Management tab (Figure 13-20) consists of the following 
application:

• Fusion Network Manager Allows the user to add Fusion 
network nodes and manage network 
telephone number.

Refer to the MA4000 Network Manager User Guide for additional information 
concerning the Fusion Network Manager feature.

• Registration Wizard Connects the system to the NEC 
Registration Service and obtains an 
Activation Code for the PBX (see 
Registration Wizard ... for additional 
information on this option).

Figure 13-20  Productivity Features - Management Tab

To complete the wizard, your computer must be connected to your 
system via direct serial cable, TCP/IP, or a modem. Also, your computer 
must use a modem or a TCP/IP network connection to the Internet to 
communicate with the NEC registration server.

During the registration process, you must provide information about 
your installation and setup. Some information is optional, but you must 
supply the required information to complete the registration process. 
The following information is mandatory:

• Site Information
— Customer Site Name
— Associate Contact Name
— Associate Contact Phone Number

• License information
— Hardware Key Code

REFERENCE

Download from Www.Somanuals.com. All Manuals Search And Download.



Productivity Features         13-29

MA4000 Installation Manager User Guide - Revision 7

— Software Key Code

Dual CPU systems require key codes for both CPUs. 

During the registration process, the wizard will connect to your system to obtain the 
key codes automatically.

After confirming your license information, the registration server sends 
the Registration Wizard an activation code. When you complete the 
wizard it copies this code to your system and activates it. 

Diagnostic Tab

The Diagnostic tab (Figure 13-21) consists of the following application:

• License Verification Tool Provides a summary of the primary 
licenses that are available, and in 
use, on the PBX system (see License 
Verification Tool ... for additional 
information on this option). 

Figure 13-21  Productivity Features - Diagnostic Tab

UNIVERGE SV8500 is not supported and the Run button is disabled.

 

NOTE

NOTE
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Maintenance Tab

The Maintenance tab (Figure 13-22) consists of the following 
applications:

• Flash Card Wizard Formats, writes, and provides backup 
for PBX files to a PCMCIA flash 
memory card (see Flash Card Wizard 
... for additional information on this 
option). 

The Flash Card Wizard option is not available for UNIVERGE SV8500, and the Run 
button will be greyed out.

• This option is not available for UNIVERGE SV8500.
• PCPro Provides centralized online HTML-

based programming access, allowing 
administraators to manage terminals, 
schedule maintenance and firmware 
updates, and remotely make moves, 
additions, or changes (see PCPro ... 
for additional information on this 
option). 

Figure 13-22  Productivity Features - Maintenance Tab

 

NOTE
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